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CHAPTER I

INTRODUCTION

Transplantation techniques for damaged or defective tissues and organs have been
improved significantly. However those conventional therapies are limited in the amount
of human donors. Hence, tissue engineering is being more magnified as an alternative
way to meet demands for replacing damaged components of humans. Furthermore, tissue
engineering potentially offers not only improvements in medical care for patients, but
also reduction in medical costs dramatically. Tissue engineering involves implanting
cells into supporting structural material —termed a scaffold- and allowing the cells to
remodel the scaffold into natural tissue, before implanting it into a patient’s body (Place,

George et al. 2009).

Most materials commonly in use as scaffolds are polymers such as synthetic,
naturally derived, or their composite polymers. Synthetic materials include poly(ethylene
glycol) (PEG), poly(ethylene oxide) (PEO), poly(lactic acid) (PLA), polycaprolactone
(PCL), or poly(lactic-co-glycolic acid) (PLGA), and examples of naturally derived
materials are chitosan, gelatin, or fibrin. Those types of polymers have respective
advantages and disadvantages. Synthetic polymers offer better control on mechanical
properties, degradation characteristics using polymer chemistry. For example,

mechanical and non-enzymatic degradation (by hydrolysis) properties of PCL, the semi-



crystalline linear resorbable aliphatic polyester with low melting point (60°C), can be
altered by changing molecular weight or co-polymerizing other monomers such as vinyl
alcohol (Engelberg and Kohn 1991). Thus, PCL is explored in forming various medical
devices (van der Giessen, Lincoff et al. 1996), templates in tissue regeneration (Htay,
Teoh et al. 2004; Li, Cooper et al. 2006), and drug delivery systems (Aliabadi, Mahmud
et al. 2005). However, using high MW PCL in forming structures for biomedical
applications has been the strategy since structures formed with low MW PCL are
unstable (Baker, Rohman et al. 2009; Guarino, Taddei et al. 2009). High MW PCL is
biostable for nearly two years (Pitt, Gratzl et al. 1981) and degradation rate is a function

of MW.

Typically used halogenated hydrocarbon solvents such as chloroform generate a
hydrophobic surface with smooth surface characteristics. Since a hydrophobic material
fails to spread water and important nutrients dissolved in water, hydrophobicity needs to
be reduced or engineered to hydrophilic condition. In addition, large scale manufacturing
requires the safe disposal of those environmentally unfriendly solvents. Although
grafting hydrophilic fragments of synthetic or natural polymers such as acrylates,
collagen, and chitosan have been explored to reduce hydrophobicity (Jones, Djokic et al.
2002; Cheng and Teoh 2004; Jones, McLaughlin et al. 2005; Chung, Wang et al. 2006;
Williamson, Black et al. 2006), regulating a number of cellular activity is also critical

while retaining the possibility of tailoring mechanical and degradation properties.

For tissue engineering to be successful, building scaffolds of the shape similar to
the tissue to be placed is important. Current techniques utilize porous sheets and the
surgeon molds into required shape (Atala, Bauer et al. 2007). However, they have
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uneven thickness due to wrinkling and overlap. Further, the quality of the regenerated
tissue is dependent on the surgeons’ ability to mold. Thus, it is important to develop

anatomical relevant scaffolds appropriate to regenerating a specific tissue.

Regeneration is a dynamic process where the porous characteristics change due to
matrix deposition and tissue maturation. Assembly and maturation of extracellular
matrix (ECM) elements in tissue regeneration play a significant role in determining the
quality of the regenerated tissue. These changes affect the transport characteristics and
nutrient distribution. Also, in vitro regeneration strategies are not characterized for high
aspect ratio tissues which have large surface area relative to the thickness (Heydarkhan-
Hagvall, Esguerra et al. 2006). In vitro cultivation system referred as bioreactors have
been explored for the successful tissue regeneration process. The bioreactor provides an
optimized environment for the cells. Many issues have to be considered in designing of
bioreactors, include nutrient fluid transfer, hydrodynamic stress, configurations of
reactors, and changes in permeability due to regeneration. These factors can be achieved

and optimized by computational fluid dynamic (CFD) study.

The objective of this study was to investigate a novel method of generating
synthetic scaffolds that has the ability to independently regulate mechanical, degradation,
and biological properties. Further, mimicking anatomically relevant structure of PCL
scaffolds was also explored. Our laboratory has discovered that PCL can be dissolved in
glacial acetic acid (AA) which allows spontaneous aggregation of PCL upon contact with
water. The hypothesis of this study is that PCL matrices generated in aqueous
environment will have the familiar biological condition in addition to retaining the ability

to regulate mechanical and degradation properties. In addition, this simple technique



can be utilized to generate anatomically relevant scaffolds. Also, a suitable bioreactor
needs to be investigated for in vitro cultivation of anatomically relevant scaffolds with

appropriate cell sources. To test the hypothesis, three specific aims are described below.

1.1. Aim 1. Characterization of a novel method to make scaffolds using the synthetic

polymer polycaprolactone (PCL).

PCL is a synthetic polymer, and structures formed using organic solvents. Hence,
it has a limitation in long term project, and tends to show a poor cellular activity. This
aim mainly focused on developing a new strategy to improve biological properties of 80
kDa Mn PCL scaffold. A novel process of dissolving PCL in acetic acid (AA) was
investigated which allows the self assembly of PCL in aqueous environment. PCL
matrices formed from self assembly method were compared with chloroform-cast
matrices to evaluate the effect of different solvents on the surface morphologies and
roughness characteristics, effects of neutralization process in the alkaline solution, tensile
properties, and stress relaxation properties. In addition, cytocompatibility and

cytoskeletal organization of human foreskin fibroblasts were tested in serum free medium.

1.2. Aim 2. Effect of blending different molecular weight of PCL and multi-layered

scaffolds on biological properties.

The resorption of PCL matrices is considerably slower than other aliphatic
polyesters due to its high crystallinity. The effects of blending low molecular weight (10
kDa, 47 kDa Mn, and 80 kDa) PCL was investigated to find the effect of MW on the
degradation rate. Further, natural polymers, gelatin and gelatin-chitosan composite, were

hybridized to enhance the bioreactivity of the PCL surface and to modulate cell survival.



PCL matrices were incubated in gelatin solution, and compared for the effects on the
surface morphology, surface characteristics, and cellular activity. In addition,
incorporating the porous structure of gelatin-chitosan mixture, known to support cell
colonization (Huang, Onyeri et al. 2005), was evaluated. Gelatin-chitosan composite
scaffolds were formed multi-layered scaffolds with self assembled PCL matrices using
lyophilization technique, and their surface characteristics and tensile properties were
evaluated. Furthermore, based on self assembly method and multi-layered scaffolds,
spherical and cylindrical shaped PCL matrices were investigated to mimic anatomically

relevant structures of human bladder and blood vessel.

1.3. Aim 3. Design of a bioreactor for bladder tissue regeneration using

computational fluid dynamic.

There is a significant lack of a bioreactor technology to utilize 3-D anatomically
relevant structures. Hence, prior to utilization of developed 3-D scaffolds, understanding
design features of the bioreactor was investigated. The bioreactor suitable for
regenerating a human bladder was simulated using COMSOL 3.5a Multiphysics. The
spherical shape of the bioreactor was designed for the bladder tissue regeneration. Based
on the human bladder size, the volume of the reactor was set to 820 mL, and the volume
of scaffold was chosen to be 755 mL with a thickness of 3 mm, similar to the human
bladder. The fluid flow analysis was performed using incompressible Navier —Stokes
equation on non-porous regions and the Brinkman equation on porous regions. Nutrient
consumption was evaluated using Michaelis-Menten type rate law for smooth muscle
cells (SMCs), with constants extracted from literature. Steady State conditions were used

with no slip condition of the walls. The effects of various factors were evaluated
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including 1) inlet shapes and locations to minimize shear stress at the inlet area, ii) flow
rate, iii) different locations of scaffolds, iv) nutrient consumption (particularly oxygen
and glucose), and v) varying cell density and permeability. Further, the diffusivity
changes due to altered void fraction in the porous structure was calculated using Mackie-
Meares relationship, and nutrient distribution mechanism in the porous region was

characterized by calculating Peclet numbers.
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CHAPTER II

BACKGROUND

2.1. Tissue engineering.

In the United States, more than 84,000 men, women and children are waiting for

organ transplants (http://www.organtransplants.org). The demands for repair and renewal

of injured tissues and organs continue to increase. However, it is apparent that this
demand cannot be met from human donors alone. Tissue engineering is one of the

alternative ways to solve this problem.

Tissue engineering is defined as an interdisciplinary field that applies the
principles of engineering and life sciences toward the development of biological
substitutes that restore, maintain, or improve tissue functions (Sterodimas, De Faria et al.
2009). Tissue engineering uses biodegradable templates referred as scaffolds made of
naturally derived or synthetic polymers to replace damaged or defective tissues, such as
bone, skin, and even organs. Tissue engineering offers improvements in medical care for

many patients, and it could reduce the medical costs dramatically.

The basic concept of tissue regeneration is shown in the Figure 2.1. There are
three essential elements for tissue engineering, which include (a) cell sources, (b)

supporting materials, and (c) regulations of cell-material interactions. Cells are harvested



from donors or patients and populated in vitro. Then expanded cells are seeded into
supporting biodegradable devices referred as scaffolds, and they are regenerated to
remodel the scaffold into the natural tissue before implanting into patients’ bodies. In
some cases, the scaffolds are placed directly into the recipient, utilizing a compartment of
the host’s own body as a regenerative device (Place, George et al. 2009). However, the
most common approach is that cell seeded scaffolds are regenerated using in vitro
cultivation system referred as a bioreactor. For tissue engineering to be successful,
scaffolds have to promote cell colonization while providing necessary mechanical
support and need to degrade as the tissue regenerates. Hence, scaffold design is pivotal
to the success of tissue engineering and this research will mainly focus on the design of

scaffolds with a novel method for bladder tissue regeneration application.



@ Expanded Cells

I

Regenerate
in vtro

Porous Scaffold

Figure 2.1. Concept of Tissue Regeneration.
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2.2. Scaffolds.

Biomaterials referred as scaffolds play a critical role in the engineering of new
functional tissues for the replacement of lost or malfunctioning tissues(Kim, Baez et al.
2000). In other words, scaffolds should have the structural integrity to support cells,
supply nutrients for cells, and control cells. Hence, the scaffold needs to be
biocompatible, biodegradable, bioresorbable, mechanically strong, and capable of being
formed into desired shapes. Since the scaffold degradation influences not only the
mechanical and structural integrity but also the cell viability and host response over the
time, degradation rate should be predictable and controllable while the tissue is
remodeled and matured (Schantz, Hutmacher et al. 2002). Degradation characteristics of
the most common biomaterials are shown in the Table 2.1. Polymers are commonly used
as a material for the scaffold as their mechanical properties can be tailored to tissue. In
addition to biological properties, ease of processing, and fundamentals are well
developed. Polymers as biomaterials used in tissue engineering can be classified into two
categories synthetic or naturally derived polymers, with a middle ground of semi-
synthetic materials rapidly emerging. Synthetic and naturally derived polymers have

their respective advantages and disadvantages described below.
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Table 2.1. Degradation characteristics of scaffolds.

Degradation
Mechanism

Materials = Molecular weight Degradation Time

83,600 Mw 50 % weight loss after
Degree of 10 days for DD of 53%
Chitosan deacetylation and Enzymatic
(DD); 53% and 84 days for DD of 72%
72% (Ren, Yi et al. 2005)

Poly(lactic-
co-glycolic 70:30 . .
acid) (lactide: glycolide) 7 weeks (Li, Feng et al. 2010) Hydrolytic
(PLGA)




2.2.1. Naturally Derived Polymer.

Naturally derived polymers such as gelatin, chitosan, etc. are obtained from
polymers found in nature. They are derived from a variety of sources such as fish scales,
pig skins, animal bones, and crab shells. The human body also contains many natural
polymers such as proteins and nucleic acids. Cellulose, another natural polymer, is the
main structural component of plants. Many methods have been explored to form porous
three dimensional scaffolds such as gas-forming (Mooney, Baldwin et al. 1996), electro
spinning (Dhandayuthapani, Krishnan et al. 2010), three dimensional printing (Sherwood,
Riley et al. 2002), and freeze-drying (Madihally and Matthew 1999). However,
lyophilization , or freeze-drying, technique is a most common method to fabricate
naturally derived polymers, because it is beneficial for those dissolved in aqueous media

(Wu, Liu et al. 2010).

Most natural polymers are condensation polymers, and water is a by-product in
their formation from monomers (Joesten 1996). Major advantages of natural polymers
are that their chemical compositions are similar to the materials present in the body and
promote cellular activity. However, many naturally derived polymers might not meet all
the requirements as an adequate scaffold because of the lack of mechanical strength and

assurance of pathogen removal.

One example of the naturally derived polymer is gelatin (Figure 2.2) denatured
form of collagen which is a completely bioresorbable material. Collagen is the major
component of the extracellular matrix (ECM) in the skin, bone, and connective tissue.

Gelatin is produced by boiling the connective tissues, bones, and skins of animals,
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usually cows and pigs. Since gelatin has excellent biodegradability and biocompatibility,
it is regarded as an ideal biomaterial for applications in tissue engineering and cell
transplantation (Hu, Kurisawa et al. 2009). Similar to collagen, gelatin is composed of a
unique sequence of amino acids (Mao, Zhao et al. 2003). Structurally, gelatin molecules
contain repeating sequences of glycine-X-Y triplets, where X and Y frequently are

proline and hydroxyproline (Pangburn, Trescony et al. 1982).
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Figure 2.2. Chemical structures of gelatin and chitosan.

Chitosan is the N-deacetylated derivative of chitin which forms the exoskeleton of
crustacean shells, and its structure is similar to glycosaminoglycan. Since, chitosan
demonstrates excellent biocompatibility (VandeVord, Matthew et al. 2002), antimicrobial
and antifungal activities (Choi, Kim et al. 2001), and controllable degradation rate

dependent on its degree of deacetylation, chitosan is widely investigated in wound

14



dressing (Risbud, Hardikar et al. 2000) and drug delivery systems (Ishihara, Obara et al.
2006). Further, chitosan can be easily fabricated into porous structures with orientated
direction. Chitosan is insoluble in water or organic solvents but soluble in aqueous acids
(pH< 6.3), which provides convenience for processing chitosan into different shapes.
Due to the protonation of the free amine groups on the chain backbone (Figure 2.2),
chitosan exhibits a high charge density in solution (Madihally and Matthew 1999).
Chitosan is also blended with collagen, alginate, GAGs and synthetic polymers (i.e.

PLGA, PCL) to fabricate suitable scaffolds (Mei, Chen et al. 2005).

2.2.2. Synthetic Polymer.

The most widely used synthetic biodegradable polymers are poly(a-hydroxy
acids), poly(lactic acid) (PLA), poly(lactic-co-glycolic acid) (PLGA), poly(glycolic acid)
(PGA), polycaprolactone (PCL) and their copolymers (Figure 2.3). These polyesters
degrade by hydrolysis, eventually releasing oligomers or monomers that feed into natural
metabolic pathways (Place, George et al. 2009). Further, these synthetic polymers can be
easily mass produced and sterilized. The advantages of synthetic polymers are that they
are easy to regulate the microstructure and degradation rate. Synthetic polymers have
strong and controllable mechanical properties. However, most synthetic scaffolds have

poor cell adhesions, thus they do not interact with a tissue in an active manner.

PGA is formed from ring opening polymerization of glycolide. When subjected
to a catalytic polymerization process, alpha glycosides polymerize to form high
molecular weight of PGA (Hutmacher, Goh et al. 2001). Since PGA is a rigid

thermoplastic material with high crystallinity, it has a high meting point of 225 °C, and
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low solubility in most organic solvents except highly fluorinated organic solvents such as
hexafluoro or propanol (Gunatillake and Adhikari 2003). However, fabricated PGA into
the porous scaffolds has strong mechanical properties initially with biocompatibility.
Although PGA has a high crystallinity, its degradation product glycolic acid is a natural
metabolite. A major application of PGA is synthetic bioresorbable sutures (Dexon,
American Cyanamide Co). However, PGA scaffolds have a significant decrease in
mechanical strength due to the bulk of mass loss. To increase its utility and control the
degradation time, PGA is often used as a co-polymer with poly (L-lactic acid) or PLA

(Falco, Patel et al. 2008).
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Figure 2.3.Chemical structures of synthetic polymers.
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PLGA is a semi-crystalline synthetic polymer and formed by copolymerization of
glycolic acid and lactic acid. Since degradation rate is a function of its lactide-to-
glycolide acid ratio and more percentages of glycolic acid increase degradation rate,
different ratios of PLA and PGA have been explored to regulate biological properties for
different purposes in biomedical applications. PLGA scaffolds are widely used for
delivery systems of long-term applications such as vaccines, drugs, genetic materials, and
its biocompatibility makes it one of the main choices (Sousa, Luzardo-Alvarez et al.
2010). Amorphous 50:50 PLGA (50% lactic acid, 50% glycolic acid) is preferred for
various tissue engineering applications because it degrades faster than other co-polymer

ratios (Lawrence, Maase et al. 2009).

PCL is a semi-crystalline linear resorbable aliphatic polyester and relatively
inexpensive relative to biomedical grade PLGA. PCL membranes formed after dissolving
in chloroform show elongation up to 1000% before breaking. PCL is subjected to
biodegradation because of the susceptibility of its aliphatic ester linkage to hydrolysis.
PCL is explored in forming various medical devices (van der Giessen, Lincoff et al.
1996), templates in tissue regeneration (Htay, Teoh et al. 2004; Li, Cooper et al. 2006),
and drug delivery systems (Aliabadi, Mahmud et al. 2005). PCL scaffolds can be
restricted because its degradation and resorption rates are considerably slower than other
aliphatic polyesters due to its hydrophobic character and high crystallinity. However,
degradation properties and mechanical properties can be altered by blending low MW
with high MW PCL as low MW has faster degradation rate(Pitt, Gratzl et al. 1981).

Nevertheless, similar to all synthetic polymers, PCL might not be useful for the scaffold
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independently because of their poor wettability and the lack of support for cellular

activity.

2.2.3. Hybrid Polymers.

There are limitations of current synthetic and natural material for the tissue
regeneration applications. Although natural polymers have the advantages of promoting
cell adhesion and repopulation by providing critical signals, their mechanical properties
may not be suitable for all tissue regeneration applications. In contrast synthetic
materials have strong mechanical properties, and easiness of controlling microstructure
and degradation rate, they lack the attachment domains and cellular signals that direct cell
growth, proliferation, and differentiation (Xue and Greisler 2003). For instance, although
bladder cells may show biocompatibility with synthetic materials in vitro (Elbahnasy,
Shalhav et al. 1998; Pattison, Wurster et al. 2005), historically, the incorporation of
synthetic materials into the bladder has met with failure due to biomechanical failure or
biological incompatibility (Elbahnasy, Shalhav et al. 1998). Therefore, hybridization of
natural and synthetic polymers can combine their respective advantages in order to
exploit the benefits of each polymer while minimizing the weaknesses. Several types of
hybridization methods are involved. Examples of these methods are shown in the table
2.2: (i) blending; polymers are blended physically without forming chemical bonds using
solvents (e.g. chloroform, benzene, and methylene chloride), and matrices are formed by
freezing and lyophilization method. (Moshfeghian, Tillman et al. 2006; Sarasam, Samli et
al. 2007), (ii) coating with other materials; natural matrices are coated on the surface of
synthetic scaffolds by submerging or spraying methods (Pankajakshan, Philipose et al.

2008; Sahoo, Toh et al. 2010), (iii) copolymerizing by modifying the surface of a polymer
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structure or forming multiple block monomers and then polymerizing the whole matrix
(Kubinova, Horak et al. 2009), and (ix) multi-layering; different types of scaffolds are

sandwiched and tightened through the holes or perforations (Lawrence, Maase et al. 2009;

Francis, Meng et al. 2010).

Table 2.2. Examples of hybridization methods.

Method Material Cell Sources Characteristics
e Controlled pore
. Chitosan - Smooth muscle morphology
Blernaling PLGA cells (SMCs) e Altered degradation
kinetic
e Developed porous
Surface Fibrin —Poly = Human umbilical structure
c:)la tin (e- vein endothelial ¢ Improved mechanical
g caprolactone)  cells (HUVEC) property and cellular
activity
Cholesterol- Mesenchmal
Copoly- Poly(2- e Improved cell adhesion
. . stem cells . .
merizing hydroxyethyl (MSCs) and proliferation
methacrylate)
e Mimicked SIS
Mouse e Improved cellular
Multi- Chitosan — embryonic p fivit
layering PLGA fibroblasts Sub ac 111\]12{ ded
(MEFs) e Substantially degrade

after 8 weeks
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2.2.4. Scaffolds Fabrications.

A number of fabrication techniques have been investigated to process porous
scaffolds (Figure 2.4), including textile technologies, solvent casting/particulate leaching,
freeze-drying (or lyophilization), solid free form and electrospining. PGA fibrous
scaffolds have been formed using textile processing techniques, which involves sufficient
structural integrity to maintain dimensions when seeded with isolated cartilage cells
(Freed, Vunjak-Novakovic et al. 1994). Another method to fabricate porous scaffolds is
to introduce porogen such as salt (NaCl) into the particulate leaching process. The
leaching of salt from PLLA polymer allows to form pores within scaffolds, the pore sizes
are dependent on the size and amount of salt crystals and are difficult to control(Lee, Kim
et al. 2004). Natural polymers such as gelatin, chitosan, or blends can be fabricated
simply using lyophilization process (Shapiro and Cohen 1997; Madihally and Matthew

1999; Ma, Wang et al. 2001).

Another technique to form porous scaffolds is using solid free form fabrication
(SFF), also known as rapid prototyping (RP). RP is the process of creating a three-
dimensional object through repetitive deposition and processing of material layers using
computer-aided-design (CAD) model of the object. There are several RP systems
developed such as stereolitography, selective laser sintering (SLS), laminated object
manufacturing (LOM), three-dimensional printing (3-DP), and fused deposition modeling
(FDM). SFF allows exact control of the internal microstructure and tissue shape;
however, problems such as residue removal and poor mechanical strength arise. The
intertwining of SFF with other methods has promising potential to create optimized

scaffolds (Hutmacher 2001).
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Electrospining has also been explored recently for tissue engineering applications.
Micro or nano scale fibers are formed using an electrical charge from a liquid. This
technique provides easily applicable nano-sized structures with the high surface area of
the fibers (Jin, Fridrikh et al. 2002). However, the general electrospining has been
limited to the fabrication of a variety of anisotropic mechanical properties, which are
important factors for designing a muscular or skeletal system (Kim 2008). The

mechanical properties are poor due to an increased pore size and porosity.

Figure 2.4. PCL matrices with different fabrication method formed by (A)solvent

casting, (B) rapidprototyping (Hoque, Hutmacher et al. 2005), and (C)

electrospining (Hiep and Lee 2010).

2.2.4. Scaffolds Properties.

Scaffolds used for tissue regeneration applications need to serve as biomaterials to
promote cell colonization and cell growth. There are some studies where cells were
implanted directly into desired locations to be regenerated. One of the examples is that
healthy chondrocytes cells from cartilage obtained from an uninvolved area of the injured
knee were isolated and cultured in the laboratory for 14 to 21 days, and the cultured

chondrocytes were then injected into the area of the defect (Brittberg, Lindahl et al. 1994).
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However, for the most cases of direct injections, implanted cells cannot be controlled by
their desirable locations. Further, the majority of mammalian cell types are anchorage-
dependent and will die, if cell substrates are not provided (Kim, Baez et al. 2000). In this
reason, scaffolds (Figure 2.5) should be biocompatible and biodegradable with the
possessions of appropriate mechanical properties and specific configurations, those allow
the initial cell attachment and colonization and provide all the signals that are needed for

cell growth, differentiation, and cell interaction (Li, Laurencin et al. 2002).

Scaffolds have to provide appropriate mechanical properties to resist in vivo
forces temporarily, and maintain mechanical support until tissues are structurally
stabilized by themselves during regeneration process. This could potentially be achieved
by an appropriate choice of mechanical and degradable properties of the biomaterials
(Kim and Mooney 1998). Since, most of naturally derived polymers lack the mechanical
strength as used in tissue and organ applications, they are often blended or multi-layered
with synthetic materials, e.g. chitin/PLGA blend scaffold (Mi, Lin et al. 2002) and

Chitosan/PLGA multi composite scaffold (Lawrence, Maase et al. 2009).

Another important consideration of tissue engineered scaffolds to regulate cell
behavior is their structural configurations such as pore size, porosity, topography, and
scaffold stiffness, because these factors promote tissue in-growth from the surrounding
host tissue. For instance, a large surface-area-to-volume ratio is often desirable, as it
allows the delivery of a high density of cells (Kim, Baez et al. 2000). Several techniques

have been explored to control porosity, pore size, and porous structure.
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Figure 2.5. Requirements for adequate scaffolds, modified from (Owen and Shoichet

2010).

Pore size is a spatial element to support cell in-growth, migration, and
morphology. Uniform distribution of cells and improvement of seeded cell density can
be achieved by employing the porous scaffold with the adequate pore size. Inappropriate
pore size ranges lead to failure in the initial network formation or cell spreading. Thus,
scaffold pore sizes can be exclusive and highly depend on the cell types (Leong, Chua et
al. 2008).For example, 3T3 fibroblast cells (ATCC) with cell size of 20 to 50 pm can
bridge greater pores than endothelial cells (ECACC) with cell size of 60 to 200 pum.
Fibroblasts can span void spaces up to 200 um, while endothelial cells can only bridge
pores with 30 to 80 um (Salem, Stevens et al. 2002). Determination method of the pore

size is still an essential tool. Scanning electron microscopy (SEM) is widely used for
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taking surface images of porous structures. However, SEM images cannot prove three
dimensional architectures and connectivity inside of scaffolds. Historically, the pore size
distributions of materials have been measured by mercury intrusion porosimetry(MIP),
which applies the Washburn equation to changes in capacitance as it is forced into the

scaffolds as a function of pressure (Jones, Atwood et al. 2009).

Porosity also is an important factor that regulates cell and matrix interactions, and
this is the commonest parameter to describe the scaffold network. The porosity is a
measure of the average void volume fraction in a specific region of porous medium
(Truskey, Yuan et al. 2004). Scaffolds with high porosity (around 90%) provides a high
surface area for cell-matrix interactions, sufficient space for ECM regeneration uniform
cell seeding, and better cell colonization (Agrawal and Ray 2001; Zeltinger, Sherwood et
al. 2001). Pore interconnectivity increases the overall surface area for cell attachment
and facilitates cell in-growth in the scaffolds. Increased interconnectivity and porosity
also affect the deposition of ECM elements (Miot, Woodfield et al. 2005).In addition, by
controlling the scaffold porosity and pore-interconnection, suitable flow channels for the
scaffold can be designed as to result in the appropriate transport of nutrients and wastes

and cellular signals for proper tissue regeneration (Sun, Darling et al. 2004).

Topography also has been found to influence cell morphology and phenotypic
expression due to the difference in cell size and cell-matrix adhesion mechanism (Nehrer,
Breinan et al. 1997; Salem, Stevens et al. 2002). Especially, surface roughness
characteristics and hydrophilicity have an important role in the regulations of cell
attachment, cell spreading, and ECM deposition. Further, different cell types respond

differently to the same surface property (Singhvi, Stephanopoulos et al. 1994). For
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example, human gingival fibroblasts (HGF) were seeded on ceramic discs with varied
roughness factor by polishing. Significantly more cells were attached on the rougher
surface (around 90nm of roughness factor) rather than polished surface (around 3nm of
roughness factor) (Mustafa, Oden et al. 2005). However, the optimal mechanisms for the
interaction between surface roughness and cell behavior have not completely determined

yet.

Stiffness of the scaffold has a significant effect on cellular activity besides porous
characteristics. Young’s modulus () can be used to measure the stiffness by calculations
from the slope of the linear portion of the stress-strain curve in the specific range of stress.
The bulk stiffness controls the overall deformation of the scaffold while each individual
cell with encounter the stiffness of the individual fibers during cell colonization
(Lawrence and Madihally 2008). Maximum contractile force generated by cross-
bridging interactions of actin and myosin filaments could be as much as 10-15% of
substrate modulus (Lo, Wang et al. 2000; Discher, Janmey et al. 2005). Effect of the
different scaffold stiffness (0.001 to 1000 MPa) on cell differentiations of three cell types
(Fibroblasts, chondrocytes, osteoblasts) has been characterized (Khayyeri, Checa et al.
2010). This result shows that percentages of cell differentiation of chondrocytes and
osteoblasts were increased by increasing scaffold stiffness whereas fibroblasts
differentiation was decreased significantly. Hence, it is apparent that determining the

adequate scaffold stiffness is also crucial factor to understand better cellular activity.

25



2.3. Cellular Activity.

Cells are the functional elements of repair and regeneration. Successful tissue
regeneration depends on the ability of cells to populate the porous structure and
synthesize appropriate extracellular matrix elements. Colonized cells proliferate and
differentiate to an appropriate phenotype or function (Nancy 2003). For that reason, the
ability to control cell proliferation and differentiation is one of the important aspects of
cellular tissue engineering. The scaffold can be considered as the part of structural
support for cells, nutrient supply for cells, and functional control of cells. Many potential
scaffolds have been tried, but the ability to define critical biomaterial properties on the
basis of specific tissue engineering applications and on a mechanistic understanding of
how cells interact with scaffolds is still in its infancy (Wood and Southgate 2008). To
select appropriate scaffolds for tissue engineering, the influence of the materials on
cellular viability, growth and function should be understood. For this purpose, cells from
appropriate region are seeded and tested in the generated scaffolds for utility in tissue

engineering.

2.4. Bladder Tissue Regeneration.

Regeneration of the bladder is utilized as a paradigm in this study. Functions of
the urinary bladder are to store urine at low pressure and to empty urine while
maintaining chemical gradients between urine and blood. Both these functions are
inherently mechanical and, in essence, the bladder is a pressure vessel subjected to
significant stresses during filling and voiding (Korossis, Bolland et al. 2006). Cellular

and extracellular components come up with those functions. The cross-sectional view of
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the bladder structure is shown in the Figure 2.6. In terms of cellular components,
urothelial cells form a multi-layered, specialized epithelium that serves as an effective
blood-urine permeability barrier. The smooth muscle cells are responsible for
accommodating bladder filling at low pressure and contract during emptying.
Extracellular components consist of collagens, proteoglycans, and glycosaminoglycans;
this matrix serves as a reservoir for growth factors and profoundly influences cell growth,

differentiation, development, and metabolic responses (Wallis, Yeger et al. 2008).
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Figure 2.6.The cross-sectional view of the urinary bladder.
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The development of organ replacement therapy through cell culture, tissue
construction and implantation has attracted considerable attention from life and materials
scientists, clinicians and engineers (Dan Wood 2008). Naturally occurring materials have
often been used to repair the bladder when it has been disrupted due to such resection,
trauma, infection, inflammation, or any number of other conditions, such as bladder
allografts, dura, placenta, and pericardium (Tsuji, Ishida et al. 1961; Kelami, Ludtke-
Handjery et al. 1970; Fishman 1J 1987; Kambic, Kay et al. 1992; Falke, Caffaratti et al.
2000). However, these materials have met failure mainly due to mechanical failure and
poor biocompatibility properties. Hence, recent studies have focused on synthetic
materials for bladder reconstruction. Synthetic materials which are widely used in
experimental and clinical settings include poly(lactide-co-glycolide) (PLGA), polyvinyl
sponges, polytetraflouroethylene (Teflon), gelatin sponge, collagen matrices, silicone,
resin-spayed paper, and polyglactin 910 (Vicryl) matrices (Kudish 1957; Bono and De
Gresti 1966; Fujita 1979; Monsour, Mohammed et al. 1987; R. Gonzalez 1995;
Rohrmann, Albrecht et al. 1996). Using pure natural or synthetic materials does not
fulfill necessary requirements (as described above) and hence, combining two polymeric

systems would be an ideal solution.

A biodegradable composite scaffold made of collagen and PGA (a material used
as a mesh for hernia repair; Sherwood Medical, St Louis, MO, USA) was shaped like a
bladder (Figure 2.7.) with polyglycolic sutures (Atala, Bauer et al. 2007). However, they
have uneven thickness due to wrinkling and overlap. Further, the quality of the
regenerated tissue is dependent on the surgeons’ ability to mold. Thus, it is important to

develop anatomical relevant scaffolds appropriate to regenerating a specific tissue.
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Figure 2.7. Bladder shape of collagen-PGA composite scaffolds (Atala, Bauer et al.

2007).

2.5. Bioreactor.

Bioreactors play a critical role in tissue engineering, not only because they
reproduce and control changes in specific environmental factors (e.g. pH, temperature,
oxygen, nutrient transfer and waste elimination) for the growth of tissue substitutes, but
also because they enable systematic studies of the responses of living tissues to various
mechanical and biochemical cues(Chen and Hu 2006). Bioreactors are utilized for a
variety of diverse applications, such as: (i) cell expansion on both a small scale for
individual patient and a large scale for multi-patient scale, (ii) production of three
dimensional tissues from dissociated isolated cells in vitro, and (ii1) directly as organ
support devices (Shachar and Cohen 2003). However, many bioreactors were designed

for two dimensional structures with small scales and disc shapes. Bioreactors with
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reasonably sized scale and mimicked anatomic porous scaffolds or direct organ
cultivation have not been completely understood yet. For tissue engineering to be an
active manner in vitro cultivation of the engineered tissues, bioreactors should be
developed in many applications to convince their requirements presented by the wide

variety of desired tissue types (Martin and Vermette 2005).

Bioreactors of different configurations, which are important during in vitro
maturation of cell seeded scaffolds, have been explored for in vitro tissue regeneration.
Among different reactor configurations, the flow through reactor is better suited for
regenerating high aspect ratio tissues due to following advantages(Lawrence, Devarapalli
et al. 2009): (a) supports uniformly which prevents deformation of the scaffold, (b)
continuous flow replenishes the nutrients while providing better control on hydrodynamic
shear stress induced by the fluid flow, and (c) easy scaled-up to clinical requirement. The
suitable bioreactor for large scale cultivation should be chosen carefully by considering
bioreactor configurations with operating conditions and designs, since cell morphology
influences the effect of different bioreactor configurations on cell growth and maturation

(Ingram and Mavituna 2000).

One of the critical requirements for bioreactors is a mass transfer involvement
such as nutrient supply and waste elimination. The most popular approach is the use of
tissue culture plastic with cell seeded scaffolds along the growth medium. However, this
traditional system has a limitation as they do not have their own blood system and the
cells are only supplied by diffusion. Even though oxygen supply by only diffusion is
sufficient for cell layers of 100-200 um, in a reactor environment, as tissues gain on size,

mass transfer has to be increased (Portner, Nagel-Heyer et al. 2005). For example, in
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vitro grown chondrocyte-poly(glycolic acid) (PGA) constructs were reported to lose their
diffusional permeability to up to 97% of its initial value after 4 weeks, proportionally to
the quantity of extracellular matrix (ECM) deposited on the construct (Bursac, Freed et al.
1996). Further, solubility of oxygen in the culture medium is poor and limited to
maximum solubility of 0.2 mol O,/m’. Hence mass transfer should be continually
provided and recirculated through the inner and outer area of porous scaffolds using
bioreactors. Nutrient transfer can be explained with diffusion and convective flow and
their dominants can be changed by the location of scaffold and channel size in the reactor.

Diffusion or convection dominants can be assessed by determining Peclet number.

Pe=—= M

where V' is the velocity, 7 is a radius of the scaffold, and Do, is the diffusion coefficient of
oxygen. A Pe number between 0 and 1 indicates that the specific bioreactor
configuration has a diffusion dominant mass transfer, otherwise, convection dominant.

Since the nutrient consumption is governed by diffusion rather than convection, it
is important to accommodate the diffusive characteristics of nutrients through the porous
structure. The change in effective diffusivity (D.y in m?/s) due to altered void fraction in
the porous structure can be calculated using Mackie-Meares relationship (Mackie and

Meares 1955; Mackie and Meares 1955; Sengers, van Donkelaar et al. 2005).

DLﬁe =D, [ﬁ} 2

where D, is the diffusion coefficient from Stokes-Einstein equation, and © is the porosity

of the scaffold. Mackie-Meares model is based on the lattice model for liquids and
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assumes that the polymer fibers are of the same size as the solutes and the polymer

network only blocks the pathway of solutes without affecting their mobility.

Most cell types used in mammalian tissue engineering respond to hydrodynamic
stress referred as shear stress. Since, hydrodynamic shear force influences cellular
alignment (Huang, Onyeri et al. 2005; Waters, Cummings et al. 2006) in the flow
direction (Gray, Pizzanelli et al. 1988; Takahashi and Berk 1996; Huang, Onyeri et al.
2005), fluid path helps align the cell in the required direction. Each different type of cells
has their own maximal sustainable shear stresses. For example, heart valve leaflets have
to sustain temporary shear stress in the range of 0.9 to 2.2 Pa (Weston, LaBorde et al.
1999), for the mammalian cell line, low shear stress of 1.0 Pa were found to be just as
damaging as high shear stress of 100 Pa, and maximal sustainable shear stress was
around 10 Pa (Mardikar and Niranjan 2000). Maximal sustainable shear stress of smooth
muscle cells was around 2.5 Pa, and cell growth was significantly slower at the higher
stress values (Papadaki, Mclntire et al. 1996). Although these results have benefits to
understand the effects of the shear stress on cell growth, however, the results were
examined using small scale tissues. Since the requirements for large scale tissues or 3D
culture of cells are different with a small size, a monolayer, or a 2D culture (Cukierman,
Pankov et al. 2001), more studies should be conducted to understand effects of

hydrodynamic stimuli.

More detailed description of bioreactor designs, complete fluid flow through
reactors and porous media, and hydrodynamic forces can be characterized by using
computational fluid dynamics (CFD). Further, CFD is possible to keep track the variable

parameters, which need to be adjusted followed by matrix deposition, cell differentiation,
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and proliferation, also can be predicted for the optimized environments. Computational
simulations have simplified mathematical models and reduced scaffold size due to
increased computational demand in simulating reactors suitable for clinical
transplantation. Also, the kinetic models are over-simplified by ignoring the mass and
structural complexities. Therefore, CFD is an invaluable tool that enables a better
understanding of the implications of fluid flow and transport on cell function and
provides important insights into the design and optimization of three dimensional

scaffolds (Hutmacher and Singh 2008).

Previously, our group members have simulated circular shapes of bioreactors, and
characterized the non-ideal fluid distribution using the residence time distribution (RTD)
(Lawrence, Devarapalli et al. 2009), optimized nutrient distribution environments for
several types of cells (Devarapalli, Lawrence et al. 2009). Also, several types of
bioreactor designs for artificial blood vessels or cardiovascular tissues have been
introduced, include a bioreactor for heart valve leaflets (Mol, Driessen et al. 2005), artery
(Iwasaki, Kojima et al. 2008), and vascular tissue (Sodian, Lemke et al. 2002). These
studies benefit for the tissue regeneration process, since there are significant amounts of
fundamental studies of in vivo and in vitro conditions for these applications. However,
cultivation systems for complex structure such as organs have not been understood.
Hence CFD analyses for the bioreactor design with mimicking anatomic structures or real
organs can enhance a suitability of real bioreactors for tissue regeneration. In this study,
main consideration is to mimic a real bladder structure of synthetic scaffold and construct

cell cultivation system.
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CHAPTER III

CHARACTERIZATION OF POLYCAPROLACTONE MATRICES

GENERATED IN AQUEOUS MEDIA

3.1. Introduction.

Polycaprolactone (PCL) is biocompatible polyester with a low melting point
(60°C). It has been explored for forming various medical devices (van der Giessen,
Lincoff et al. 1996), templates for tissue regeneration (Htay, Teoh et al. 2004; Li, Cooper
et al. 2006) and drug delivery systems (Aliabadi, Mahmud et al. 2005). Apart from its
low melting point, the ability to tailor the mechanical properties and non-enzymatic
degradation (by hydrolysis) rate of PCL by altering the molecular chain length are very
attractive features (Engelberg and Kohn 1991); PCL matrices formed after dissolution in
chloroform show elongation up to 1000% before breaking (Averous, Moro et al. 2000).
However, the poor wettability of the prepared matrices prevents uniform distribution of
proteins and cell adhesion, thus compromising their application in biomedical devices

(Lee, Kim et al. 2004).

To enhance the bioreactivity of the PCL surface and to modulate cell survival, a
number of studies have evaluated the effect of the solvents used during matrix generation

process (Tang, Black et al. 2004). Typically used halogenated hydrocarbon solvents such
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as chloroform and dichloromethane have been shown to generate a hydrophobic
surface with smooth surface characteristics. To reduce the surface hydrophobicity,
grafting hydrophilic fragments of synthetic or natural polymers such as acrylates,
collagen and chitosan has also been explored (Jones, Djokic et al. 2002; Cheng and
Teoh 2004; Jones, McLaughlin et al. 2005; Chung, Wang et al. 2006; Williamson,
Black et al. 2006). Alternatively, etching the surface at the nanoscale using sodium
hydroxide is also proposed (Serrano, Portoles et al. 2005). Further, melt molding
techniques have used molds with different surface features (Hanson, Jamshidi et al.
1988). Nevertheless, the effect of these modifications on the resulting polymer is not

completely understood.

In this study, a novel process of dissolving PCL in acetic acid (AA) was
explored which allows self-assembly of PCL in an aqueous environment. To
understand the utility of these matrices in biomedical applications, their surface
characteristics, effect of neutralizing in alkaline solution, tensile properties and stress
relaxation properties were investigated. Matrices formed by dissolving in chloroform
and air drying, an method that has been widely investigated (Cheng and Teoh 2004;
Tang, Black et al. 2004), were used as control. In addition, the cytocompatibility and
cytoskeletal organization of well-characterized fibroblasts were tested in serum-free
medium. The results showed a significant benefit of the modified process relative to

casting matrices with chloroform.

3.2. Materials and Methods.

PCL of 80 kDa (in number Mn) and gelatin (type-A) were purchased from
Sigma—Aldrich (St. Louis, MO). Glacial AA was purchased from Pharmco Products
Inc. (Brookfield, CT). Pure ethanol was from AAPER (Shelbyville, KY). Human
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foreskin fibroblast cells (HFF-1, cell line) were purchased from the American Type

Culture Collection (Walkersville, MD). All other chemicals were of reagent grade.

3.2.1 Preparing solutions and forming blends.

PCL solution (10% (w/v)) was prepared in glacial AA, and the same
percentage of PCL solution was prepared in chloroform. Gelatin solution (5% (W/v))
was prepared in distilled water. All solutions were prepared fresh or stored for no

longer than 4 days. Long-term storage is deleterious to self-assembly of PCL matrix.

3.2.2. Forming matrices.

PCL matrices were made in 5 cm diameter Teflon dishes for tensile testing

and surface analysis using two methods:

* Method 1: dispensing 2-3 mL PCL solution dropwise on top of a water bath.

* Method 2: layering 2 mL PCL solution on the bottom of the dish and dipping the

entire dish into a larger container of water.

Although matrices formed spontaneously in both the modes, they were
undisturbed for 5 min to allow the process of matrix formation to complete.
Generated matrices were allowed to air dry. Some of those PCL matrices were
incubated in gelatin solution for 30 min, and were then allowed to air dry. Both
gelatin-coated and uncoated matrices were removed from the dish, and placed in an
ethanol bath for 15 min. These matrices were used for tensile testing measurements
and surface analysis. Chloroform—cast matrices were made in the same Teflon dishes

by layering 2 mL PCL solution and air drying.
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To form porous matrices, the water bath was replaced with NaHCO3 solutions
which react with AA to form CO,. To evaluate the effect of concentration of
NaHCOj solution on matrix formation, experiments were performed using 2%, 5%
and 8% (w/v) NaHCOj; solutions. The formed matrices were dipped in a 1 N sodium
hydroxide solution for 10 min to test the effect of etching on surface roughness and

charge.

For surface analysis of formed matrices, samples were incubated in ethanol for
10 min and allowed to dry overnight in a vacuum desiccator. Dry matrices were
attached to aluminum stubs with carbon paint and sputter coated with gold for 1 min.
The surface architecture of the matrices was analyzed by scanning electron
microscopy (SEM, JEOL 6360, JEOL USA Inc., Peabody, MA) at an accelerating

voltage of 21 kV.

3.2.3. Surface roughness and charge analysis.

Surface roughness analysis of matrices was done by atomic force microscopy
(AFM) using a DI Nanoscope V Multimode Scanning Probe Microscope (Digital
Instruments, Veeco Metrology Group, Santa Barbara, CA) at ambient conditions, as
described previously (Sarasam, Krishnaswamy et al. 2006) In brief, at least triplicate
samples were prepared per condition. Each sample was split into four, and each of the
four samples was attached to iron substrates using double-sided tape (for the
roughness test) and conductive tape (for the charge test). In each sample, AFM
analysis was performed by randomly choosing 10 different locations, with a field size
of 5 um x 5 uym. Topographic images were obtained in tapping mode at a scan rate of
1 Hz and 256 scanning lines using commercial silicon micro-cantilever probes
(MikroMasch, Portland, OR) with a tip radius of 5-10 nm and a spring constant of 2-5
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N/m. Height images were captured at the probe oscillation resonance frequency of
160 kHz. The roughness factor, Rq, is the root mean square average of the number, n,
of height deviations (Zi) taken from the mean data plane, calculated using the

equation:

Rg=+lZ>/n (3.1)

For surface charge, topographic images were obtained in tapping mode using
micro-cantilever probes coated with platinum—iridium with a tip radius of 20 nm.
Then topographic images were rescanned in electrical force mode. Surface potential

charges were recorded using the associated software (Nanoscope, version 7).
3.2.4. Tensile testing.

Tensile testing was performed by the method previously described (Raghavan,
Kropp et al. 2005; Sarasam and Madihally 2005). In brief, 30 mm x 10 mm
rectangular strips were cut from each matrix and strained to break at a constant
crosshead speed of 10 mm/min using and Instron 5842 (Instron Inc., Canton, MA).
Tensile stress and strain were determined using the associated software Merlin
(Instron Inc.). Samples were tested either in the dry state at 25 °C or in the wet state
at 37 °C by immersion in phosphate-buffered saline (PBS) using a custom-built
environmental chamber. The elastic modulus was calculated from the slope of the
linear portion (0.1-5% strain range) of the stress—strain curve. To measure the
thickness of the matrices, digital micrographs were obtained at various locations
through an inverted microscope (Nikon TE2000U, Melville, NY) equipped with a
CCD camera, as described previously (Raghavan, Kropp et al. 2005). These images

were quantified for the thickness using image the analysis software Sigma Scan Pro
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(SPSS Science, Chicago, IL), calibrated using a micrograph of a hemocytometer at
the same magnification. Four or five images were obtained per sample with at least
20 points per image. The calculated minimum thicknesses were used to determine the

stress values in each sample.
3.2.5. Stress relaxation testing.

Stress relaxation testing was performed using the previously described
procedure (Mirani, Pratt et al. 2009). In brief, 30 mm x 10 mm rectangular matrices
were tested using the Instron 5542 mechanical testing machine. The load limits were
predetermined by the linear portion of the stress—strain curves obtained previously
under tensile testing. Samples were subjected to a constant step tensile strain applied
at the rate of 1.0% s ' for 50 s and the sample was allowed to relax for 100 s. Each

single test had five steps of ramp-hold cycles.
3.2.6. Evaluating cell adhesion.

HFF-1 cells were seeded onto each sample and maintained in serum-free
FGM medium purchased from Lonza (Walkersville, MD). The cultures were
maintained in 5% CO,/95% air at 37 °C with medium changes every 48 h. Cells were
detached with 0.01% trypsin—10 uM EDTA, obtained from Invitrogen Corp.
(Carlsbad, CA). Viable cell numbers were determined using the Trypan Blue dye
exclusion assay. Ten thousand viable cells were seeded onto the control, and 25,000
cells were seeded uniformly onto the scaffolds. Growth medium (2 mL) was added

and the cells were incubated for 48 h.

After 2 days, samples were fixed in 3.7% formaldehyde for 30 min at room

temperature. Samples were washed three times with PBS, and permeabilized with -
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20 °C ethanol overnight at 4°C (Huang, Onyeri et al. 2005). The samples were
stained with Alexa Fluor 546 phalloidin (Molecular Probes, Eugene, OR) for 3 hours
at -4 °C in the dark. Samples were counterstained with DAPI following the vendor’s
protocol (Invitrogen) and observed under a fluorescence microscope (Nikon TE2000),
and digital micrographs were collected from different locations using the attached
CCD camera. Surface architecture of matrices was also analyzed by SEM to observe

changes in the architecture due to incubation with cells.

3.2.7. Statistical analysis.

All cell culture experiments were repeated three or more times with
quadruplicate samples. All tensile testing and compliance testing were repeated four
or more times and average and standard deviations were calculated. Significant
differences between two groups were evaluated using a one way analysis of variance
(ANOVA) with 99% confidence interval. When P <0.01, the differences were

considered to be statistically significant.

3.3. Results.

3.3.1. Macroscopic properties of matrices.

Dispersion of PCL solution in a water bath formed matrices quickly in both
methods. However, dropwise dispersion (method 1) of PCL solutions formed a
uniform matrix (Figure 3.1-B) unlike spreading PCL solution (method 2) (Figure
3.1-C); matrices generated using method 1 had more uniform thickness, and these
matrices were used for the subsequent analyses described below. When PCL solution
stored for more than 4 days was used, no spontaneous matrix formation was observed.

This could probably be due to the acid hydrolysis decreasing the molecular weight of
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the polymer and the inability to form an interpenetrating network. All solutions for

subsequent testing were freshly prepared for forming matrices.

To test the possibility of incorporating porous architecture into the matrices,
solutions were dispersed in 8% (w/v) sodium bicarbonate solution. Matrices formed
much faster in these baths than in a water bath and formation of bubbles due to the
release of CO, was also observed. These bubbles created pores in the formed
matrices (Figure 3.1-D). When self-assembled matrices were immersed in gelatin
solution, macroscopically their characteristics were identical to Figure 3.1-B (data not

shown).

Figure 3.1. Macroscopic view of the PCL matrices. (A) Matrix formed in
chloroform, (B) Matrix formed in Acetic Acid by Method 1, (C) Matrix formed in

Acetic Acid by Method 2, (D) Matrix formed using 8% (wt/v) NaHCOs.
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Next, formed matrices were analyzed using SEM to better understand the
microarchitecture. Chloroform—cast matrices had a smooth surface and appeared like
a fused network of crystals (Figure 3.2-A) with no porosity on both sides of the
matrix. However, self-assembled PCL matrices had a rougher surface architecture
and the surface facing the air had a number of micropores (Figure 3.2-B). Matrices
formed in NaHCOj; bath showed a number of micropores although the walls appeared
smooth. Upon immersion in gelatin solution, self-assembled matrices (Figure 3.2-D)
had a reduction in pore size and surface roughness, probably due to the presence of
gelatin. However, no significant change was observed in chloroform—cast PCL

samples after dipping in gelatin solution.
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Figure 3.2. Comparison of surface characteristics of PCL matrices. Micrographs of matrices formed by dissolving (A) PCL in
chloroform; (B) PCL in AA; (C) PCL in AA and reaction with NaHCOs; (D) PCL in AA and incubation in gelatin solution. Scale bar
=50 pm..
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3.3.2. Analysis of surface roughness.

Next, the effectiveness of generating matrices on the surface roughness was
compared with the chloroform-cast PCL matrices. AFM analysis of formed matrices in
AA (Figure 3.3-A) showed a statistically significant increase in roughness relative to
chloroform—cast matrices (Figure 3.3-C). While average roughness factor of PCL
matrices formed in AA was 150 nm, employing chloroform resulted in an average

roughness factor of 30 nm (Figure 3.3-E).

To assess the effect of incubation in an alkaline solution for neutralization of AA
bound to self-assembled matrix, PCL matrices were immersed in 1 N NaOH for 10 min.
These results showed a significant reduction in the roughness (referred as etching in
Figure 3) of self-assembled PCL matrices. After 10 min of incubation in NaOH at room
temperature, the roughness factor decreased to 75 nm. There was only a marginal
reduction in chloroform-cast PCL matrices (Figure 3.3-D). Thus while neutralizing the
remaining AA in self-assembled PCL matrices; one has to consider the effect of alkaline

solution concentration and the incubation time.
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Figure 3.3. Surface roughness characteristics. (A) PCL in AA; (B) PCL in AA after etching; (C) PCL in chloroform; (D) PCL in

chloroform after etching; (E) variation in roughness values. Average and standard deviations from at least four samples for each

condition are shown. Micrographs correspond to 5 um x 5 pm area and the roughness coordinate is 500 nm.
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3.3.3. Alteration in surface charge.

Next, we investigated whether the self-assembled PCL matrix shows a
different surface charge relative to chloroform-cast matrices. For this purpose,
formed matrices were assessed for surface charge using AFM. The analyzed surface
in contact with the probe was that in contact with the water bath. These results
showed (Figure 3.4) that self-assembled matrices had a net positive surface charge
(+9.988), whereas chloroform-cast matrices had a negative surface charge (-9.998).
Since gelatin has a net negative charge in acidic conditions, immersion in gelatin
solution resulted in ionic binding of gelatin to the PCL surface. The surface charge of
gelatin-coated self-assembled PCL matrix changed to negative. This suggested the
possibility of immobilizing gelatin via ionic interactions. Interestingly, the alkaline

etching did not alter the surface charge characteristics in both processes
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; — Etched
© 51
(o))
8
g o
L)
&
= -5
S
n
_10 J

AA-1:0:0 Chloroform

Figure 3.4. Surface charge characteristics. Matrices formed by different solvents,

and one of the samples were coated with gelatin
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3.3.4. Effect on tensile properties.

Next, alterations in the tensile strength of matrices were evaluated. These
results (Figure 3.5-A) showed that chloroform-cast matrix had a higher tensile stress
and strain than self-assembled matrix. The break strain of chloroform—cast matrix
was more than 700%, and the break stress was 12 MPa. The break strain of self-
assembled matrix was 230%, and its break stress was between 3.0 and 3.5 MPa.
Elastic modulus was estimated using the initial linear range (0.1-5%) of the stress-
strain curve. These results showed that self-assembled matrices were more elastic
than chloroform—cast matrices (Figure 3.5-B). The elastic modulus of the self-
assembled matrix was 40 MPa, relative to 140 MPa in chloroform—cast matrices.
Both scaffolds had a similar thickness (100 um). However, this does not mean that
the packing density of the two conditions is the same. This observed difference in
elastic modulus could be due to reduced packing of polymer chains with an

interpenetrated network formation during self-assembly.

When matrices were tested in the hydrated condition (Figure 3.5-A), break
stress was similar to dry conditions but break strain increased in self-assembled
matrices. However, in chloroform-cast matrices both break stress and break strain
decreased slightly. Elastic modulus (Figure 3.5-B) decreased in both cases by nearly

50%.
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Figure 3.5. Effect of different solvents on stress-strain behavior of PCL matrices. (A) Stress-strain behavior, (B) Elastic modulus

of matrices calculated from the linear region of stress-strain curve.
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3.3.5. Effect on stress relaxation properties.

PCL is known to behave like a viscoelastic material which stores and
dissipates energy within the complex molecular structure, producing hysteresis and
allowing creep and stress relaxation to occur (Duling, Dupaix et al. 2008). Hence, a
full description of the mechanical response of materials requires nonlinear viscoelastic
behavior. To understand the effect of self-assembly on the polymeric matrix, stress
relaxation was tested. These results (Figure 3.6) showed that both self-assembled and
chloroform-cast matrices showed similar behavior in ramp and hold cycles. In the first
ramp and hold cycle, both matrices showed high stress values for the same amount of
strain. However, in the successive ramp-hold conditions, there were no significant
differences. After the first ramp-hold, successive ramp-hold tests showed similar
stress levels, suggesting that the hysteresis loss could be negligible and hence that it
might be possible to use these matrices in applications where tissues will be subjected
to cyclical loading conditions. Electrospun PCL fibers have been shown to have
similar behavior (Duling, Dupaix et al. 2008). Thus, one could refer to the first cycle
as the preconditioning cycle. Nevertheless, self-assembled matrices experienced
nearly half the stress relative to chloroform—cast matrices for the same strain range in
all the cycles. This supported the fact that chloroform—cast matrices were harder than

self-assembled matrices.

One interesting difference between the two types of matrices was the level of
stress experienced during the loading part of each cycle. Chloroform—cast matrices
showed an initial surge in stress which reduced to a lower level despite further
application of strain. This behavior was not observed in self-assembled matrices.

One could attribute this difference in behavior to the alteration in the interpenetrating
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network architecture which accumulates and disperses the stress during loading.
Importantly, preconditioning and relaxation allowed the self-assembled matrices to go
beyond the break strain range observed in linear tensile loading, particularly in self-

assembled PCL matrices.
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Figure 3.6. Stress relaxation behavior of different materials. (A) Effect of casting process; (B) loading behavior of chloroform—
cast matrix in different cycles at the rate of 1.0% s ' for 30 s; (C) loading behavior of self-assembled matrix in different cycles at the
rate of 1.0% s ' for 30 s; (D) effect of casting process at wet condition (37 °C); (E) loading behavior of chloroform—cast matrix in
different cycles at the rate of 1.0% s ' for 30 s at wet condition (37 °C); (F) loading behavior of self-assembled matrix in different
cycles at the rate of 1.0% s ' for 30 s at wet condition (37 °C).
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3.3.6. Effect on cellular activity.

Microarchitecture analysis along with surface charge showed the possibility of
immobilizing gelatin directly onto PCL. To understand the functional implications of
these changes, the cell morphologies of HFF-1 were evaluated in serum-free
conditions. These results (Figure 3.7) showed increased presence of HFF-1 cells on
self-assembled PCL matrices, with well spread spindle shape. Self-assembled
matrices immersed in gelatin showed a qualitative improvement in the retention of
seeded cells on the surface. Further, HFFs showed peripheral distribution of actin
filaments, similar to cells on tissue culture plastic (TCP) surface. On the other hand,
chloroform-cast matrices showed very few cells with and without gelatin coating.
This significant difference suggests that forming self-assembled matrices in aqueous
medium helps improve cell adhesion to PCL even in the absence of serum proteins.
Counterstaining with DAPI confirmed the presence of nuclei, along with the actin

fiber, suggesting that the PCL structure promotes cell attachment.

To understand the cellular interactions better, samples were evaluated using
SEM (Figure 3.8). The morphology of self-assembled matrices was similar to those
observed prior to cell seeding; PCL-only matrices showed increased surface
roughness and the presence of gelatin reduced the roughness. Cells attached and
spread throughout matrix despite the presence of micropores in the matrix on self-
assembled matrices. On chloroform-cast matrices, not many cells were detected,

probably due to loss of weakly adherent cells during the sample preparation.
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Figure 3.7. Cell spreading of fibroblasts. Fluorescence micrographs of cells stained for actin and nucleus after 48 hrs of incubation. (A)

Tissue Culture Plastic, (B) PCL-AA, (C) PCL-AA + gelatin, (D) PCL-chloroform, (E) PCL-chloroform + gelatin.
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Figure 3.8. Cell spreading of fibroblasts analyzed by SEM (A) Chloroform-casted matrix, (B) PCL-AA, (C) Chloroform-casted matrix and

incubated in gelatin solution, (D) PCL-AA + gelatin.
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3.4. Discussion.

In this study, a novel method of generating PCL-based matrices in an aqueous
environment was evaluated. The self-assembly of PCL into matrices was observed in
concentrated (>5%) solutions of PCL upon contact with water. This precipitation into
stable matrices did not occur with PCL of 10 kDa Mn, probably due to the lack of stable
interpenetrating network formation. The matrices that formed had increased roughness
relative to chloroform-cast matrices. Other researchers have measured the surface
roughness of chloroform—cast PCL matrices and reported a roughness of less than 100

nm (Cheng and Teoh 2004).

Assessed tensile properties showed a reduction in self-assembled matrix relative
to chloroform—cast matrix. However, the self-assembled matrices had a break stress that
is comparable to that of small intestinal submucosa (3 MPa) (Lawrence, Maase et al.
2009), a natural matrix utilized in tissue regeneration. Further, the calculated elastic
modulus was comparable to that of small intestinal submucosa. Hence, the reduction in
elastic modulus is advantageous in tissue regeneration strategies as it reduces the
mismatch in mechanical properties with the surrounding tissues. Measured stress
relaxation characteristics showed less accumulation of stress in self-assembled matrices
relative to chloroform-cast materials. A significant difference between self-assembled
matrix and chloroform-cast matrix was relaxation during the loading phase of
chloroform—cast matrix. This was not observed in self-assembled matrices, which could
be attributed to alteration in the packing of the polymeric chains. However, one has to
perform experiments with varying loading and relaxation times to better understand the

viscoelastic behavior as viscoelastic behavior significantly depends on the loading and
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relaxation times. Further, one has to test the effect of temperature on the viscoelastic

behavior.

Previously, our laboratory has shown the possibility of blending PCL with
chitosan uniformly at low concentrations (<2%) using 70% AA solution (Sarasam and
Madihally 2005; Sarasam, Krishnaswamy et al. 2006). When crystalline properties were
evaluated (using wide-angle X-ray diffraction, melting temperature and glass transition
temperature), no significant changes were observed in PCL crystalline properties. The
increased roughness could be attributed to the different mode of assembly of PCL, similar
to results reports by others using different solvents (Tang, Black et al. 2004). One
possibility for different assembly is that the dissolution of PCL in acidic environment
could introduce a charge in the PCL backbone. This could create an affinity for water on
one side while the nonfunctionalized regions still retain hydrophobicity. Thus the
hydrophobic regions could randomly aggregate, forming a rough architecture.
Interestingly, surface formed in contact with water was hydrophilic as water uniformly
distributed when added dropwise onto the dry matrix. However, there could be a change
in the surface characteristics on the side exposed to air. One has to explore the
differences in the characteristics of the matrix on both sides and understand the

mechanism of self-assembly.

When cellular activity was measured, increased cell adhesion was observed on
self-assembled matrices. Further, cell spreading was similar to TCP, unlike other reports
in which cell spreading was shown to be minimal on chloroform—cast PCL matrices
(Serrano, Pagani et al. 2004). In the absence of serum, adhesion to chloroform—cast PCL

was minimal. Thus the new simple technique shows a significant improvement in
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cellular interactions. Since matrix topography affects cell spreading characteristics
(Huang, Siewe et al. 2006), the observed variation in cellular activity could be attributed
to the significant increase roughness. A number of previous studies have investigated
systematically the effect of surface porosity and roughness on cell proliferation rates
(Walboomers, Croes et al. 1998) and (Degirmenbasi, Ozkan et al. 2009). Further, this
increase may be required to observe the marked effect as nanoscale (100 nm) variation in
surface roughness showed no significant difference in cellular activity (Serrano, Pagani et
al. 2004). Alternatively, the observed differences could also be due to the changes in the
surface energy along with the changes in the adhesion of proteins present in the medium.
However, detailed cell colonization studies, such as growth characteristics and alteration
in secretion of matrix elements, have to be analyzed. In addition, analysis of cellular
activity needs to be extended to include other types of cells. These findings open a new
set of possibilities to understand the influence of charge and roughness separately on
macromolecular interactions and cell colonization, which has not been well understood in

tissue regeneration.

This study assessed only the formation of matrices in an aqueous environment.
To utilize this technique, one has to explore the possibility of easy layering onto various
devices in an aqueous environment. The utility of this technique in forming three
dimensional porous structures needs to be explored and compared to other techniques
(Coombes, Rizzi et al. 2004). In addition, the three-dimensional matrices formed via a
reaction to generate CO, had pores with a wide distribution in size. Further studies are
necessary to improve the method of forming porous structures with better control of pore

size. Nevertheless, there are many approaches to incorporating the porous architecture.
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For example, one could use the self-assembled PCL matrix to support porous structures

formed using natural polymers (Lawrence, Maase et al. 2009).

In summary, the results show that PCL matrices can be generated using the novel
technique in aqueous media. Self-assembled matrices showed an increase in roughness,
which was decreased after immersion in NaOH solution. Measured tensile properties
showed a reduction in elastic modulus but with similar stress relaxation behavior relative
to chloroform—cast matrices. Cell adhesion and spreading were significantly improved
on the self-assembled matrix. Thus, this technique offers a significant opportunity to

enhance the use of PCL in biomedical applications.
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CHAPTER IV

EFFECT OF BLENDING DIFFERENT MOLECULAR WEIGHT OF
POLYCAPROLACTONE AND IMMOBILIZATION OF THE NATURAL

POLYMER ON BIOLOGICAL PROPERTIES

4.1. Introduction.

Polycaprolactone (PCL) is semi-crystalline linear aliphatic polyester formed from
ring opening polymerization of caprolactone. Due to biocompatibility and excellent
tensile strength, PCL is explored in forming various medical devices (van der Giessen,
Lincoff et al. 1996), templates in tissue regeneration (Htay, Teoh et al. 2004; Li, Cooper
et al. 2006), and drug delivery systems (Aliabadi, Mahmud et al. 2005). Membranes of
PCL formed by air drying chloroform show elongation up to 1000% before break.
Further, its low melting point (60°C) allows processing into various forms by variety of
techniques. However, wide use of PCL in biomedical applications in hindered by two
properties: 1) bioregulatory activity and ii) direct relationship of resorption rate with

molecular weight.

Formed PCL surfaces are typically hydrophobic and show poor wettability, which
prevents uniform distribution of proteins. There has been a significant effort to improve

bioactivity of PCL via co-polymerization (Park, Wu et al. 1998), grafting RGD peptides
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(necessary for cellular attachment) (Eid, Chen et al. 2001), blending with other
hydrophilic polymers (Wei, Gong et al. 2009), or surface treatment (Cheng and Teoh
2004). Previously, we reported a novel process of generating PCL flat matrices in
aqueous medium, which decreased hydrophobic surface properties (Pok, Wallace et al.
2010). Immobilizing gelatin on to these surfaces was also possible, which promoted cell

adhesion even in the absence of serum.

PCL is subjected to biodegradation because of the susceptibility of its aliphatic
ester linkage to hydrolysis. Resorption of PCL matrices is considerably slower than other
aliphatic polyesters due to its hydrophobic character and high crystallinity. However,
using high MW PCL in forming structures for biomedical applications has been a
common strategy since structures formed with low MW PCL are unstable (Baker,
Rohman et al. 2009; Guarino, Taddei et al. 2009). High MW PCL is biostable for nearly
two years (Pitt, Gratzl et al. 1981) as the degradation rate is a function of MW.
Interestingly, combining structural integrity while altering the degradation of PCL is not
well investigated. In particular, influence of blending different molecular weights of PCL

in forming structures has not been explored.

For tissue engineering to be successful, building scaffolds of the shape similar to
the tissue to be replaced is important. Current techniques utilize porous sheets and the
surgeon molds the sheets into required shape (Atala, Bauer et al. 2007). However, they
have uneven thickness due to wrinkling and overlap. Further, the quality of the
regenerated tissue is dependent on the surgeons’ ability to mold. Thus, it is important to

develop anatomical relevant scaffolds appropriate to regenerating a specific tissue.
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The objective of this study was to evaluate the possibility of blending different
MW (80 kDa, 46 kDa and 10 kDa Mn) in the same solvent. Self assembled matrices
were evaluated for degradation characteristics, tensile properties, effect of neutralization
using alkaline solution and cell adhesion. Further, ability to assemble in anatomically
relevant tubular and spherical shapes was also investigated. In addition, incorporating the
porous structure of gelatin-chitosan mixture, known to support cell colonization (Huang,
Onyeri et al. 2005), was evaluated. Formed composite matrices were evaluated for
surface characteristics and tensile properties. These results showed significant potential

for using PCL self assembly in tissue regeneration.

4.2. Materials and Methods.

PCL of 80 kDa, 10 kDa (in number Mn), chitosan of low molecular weight, and
type A porcine skin gelatin were purchased from Sigma Aldrich (St. Louis, MO). PCL of
46 kDa (in number Mn) was purchased from Polysciences (Warrington, PA). Glacial
acetic acid was purchased from Pharmco Products Inc (Brookfield, CN). Pure ethanol
was from AAPER (Shelbyville, KY). NaHCO; was purchased from EMD Chemicals Inc
(Gibbstown, NJ). Human Foreskin Fibroblasts (HFF-1, cell line) was purchased from
American Type Culture Collection (Walkersville, MD). All other chemicals were of

reagent grade.

4.2.1. Preparing Solutions and Forming Blends.

From each MW PCL, 10% (wt/v) solutions were prepared in glacial acetic acid.
Blend solutions containing different MW PCL were prepared by mixing equal volumes of

individual solutions using factorial design of experiments 1:0:0, 1:0:1, 1:1:1, 0:1:0 (all
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abbreviations are in the order of 80:46:10 kDa Mn). A solution of 0.5% chitosan and 0.5%
gelatin composite was prepared in water with 1 m acetic acid. All solutions were
prepared fresh or stored and used within 2 days. Long-term storage is deleterious to

membrane formation.

4.2.2. Forming Matrices.

PCL matrices were made using the previously described procedure (Pok, Wallace
et al. 2010). In brief, 5 cm diameter Teflon dishes containing 10 mL water were used for
water baths. Two to three milliliter of the PCL solution was dropped on the top of a
water bath. Although matrices formed spontaneously by contacting with water, they
were undisturbed for 5 minutes to allow the process of matrix formation to complete.
Generated matrices were allowed to air dry. These matrices were used for mechanical

testing measurements, surface roughness, degradation and cellular activity analysis.

Some of the formed matrices were dipped in a 1 N sodium hydroxide solution for

10 minutes to test the effect of neutralizing the acetic acid in an alkaline solution.

Silicone rods of 6 mm outer diameter were used to make tubular shapes useful in
vascular graft application. Rods were immersed in PCL solution for few seconds and
immersed in water bath immediately. This step was repeated three times in fresh PCL
solution and water to form thicker matrices. Self assembled PCL tubes were analyzed for
surface characteristics using SEM by following the procedure described for 2-D matrices.
In addition, matrices of bladder shape (spherical shape) were made using latex balloons

with the same method of the tubular self assembly.

Self-assembled 2-D PCL matrices of 1:0:1 sample was sandwiched with gelatin-

75



chitosan porous structure by the previously reported method (Lawrence, Maase et al.
2008) with modifications. In brief, approximately 5 mL of 0.5 % (w/v) chitosan
containing 0.5 % gelatin were poured into 5 cm diameter Teflon dishes. Formed PCL
matrices were laid down on the solutions, and 5 mL of solution were poured onto
surfaces of PCL matrices. These samples were frozen at -80°C for 6 hours and

lyophilized at -80°C for 24 hours.

4.2.3. Surface Analysis by SEM.

All self assembled samples were incubated in ethanol for ten minutes and allowed
to dry overnight in a vacuum desiccator. Dry matrices were attached to aluminum stubs
with carbon paint and sputter-coated with gold for one minute. Surface architecture of
matrices was analyzed using a scanning electron microscope (JOEL 6360, Jeol USA Inc.,

Peabody, MA) at an accelerating voltage of 15kV.

4.2.4. Surface Roughness Analysis.

Surface analysis of membranes was done by atomic force microscopy (AFM)
using a DI Nanoscope V Multimode Scanning Probe Microscope (Digital Instruments,
Veeco Metrology Group, Santa Barbara, CA) at ambient conditions, as described
previously (Pok, Wallace et al. 2010). In brief, sample films were attached onto iron
substrates using double-sided tape. Topographic images were obtained in tapping mode
using commercial silicon microcantilever probes (MikroMasch, Portland, OR) with a tip
radius of 5-10 nm and spring constant 2-5 N/m. The size of analyzed field was 5 ym % 5
pum at a scan rate of 1 Hz and 256 scanning lines. Height images were captured at the

probe oscillation resonance frequency was ~160 KHz. Images of each sample were
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captured at different locations, and then the roughness factors were calculated using
associated software (Nanoscope, Version 7). The roughness factor Ry is the root mean

square average of ‘n’ number of height deviations (Z;) taken from the mean data plane

Rg=+Z7In (4.1)
4.2.5. Evaluating Cellular Activity.

Human Foreskin Fibroblasts (HFF-1, cell line) was purchased from American
Type Culture Collection (Walkersville, MD, USA) and maintained in Dulbecco’s
modified Eagle medium supplemented with 4 mM L-glutamine, 4.5 g/L sodium
bicarbonate, 0.1 mM B-mercaptoethanol, 100 U/mL penicillin-streptomycin, 2.5 g/mL
amphotericin, and 10% fetal bovine serum (Invitrogen Corp., Carlsbad, CA, USA). The
cultures were maintained in 5% CO; /95% air at 37°C with medium changes every 48
hours. Cells were detached with 0.01% trypsin - 10 uM EDTA, obtained from Invitrogen
Corp., (Carlsbad, CA, USA). Viable cell numbers were determined using trypan blue dye
exclusion assay. 10,000 cells were seeded onto the tissue culture plastic, and 25,000 cells
were seeded uniformly onto the scaffolds. All cells were incubated in 0.5 mL of growth

medium for 72h.

After two days, samples were fixed in 3.7% formaldehyde for 30 min at room
temperature. Samples were washed thrice with phosphate buffered saline (PBS), and
permeabilized with -20 °C ethanol overnight at 4 °C (Huang, Onyeri et al. 2005). The
samples were stained with Alexa Fluor 546 phalloidin (Molecular Probes, Eugene, OR)
for 3h at -4 °C in the dark. Samples were counterstained with DAPI following vendor’s

protocol (Invitrogen Corp., Carlsbad, CA, USA) and observed under a fluorescence
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microscope (Nikon TE2000, Melville, NY) and digital micrographs were collected from

different locations using the attached CCD camera.

4.2.6. Tensile Testing of Matrices.

Tensile testing was performed by the method previously described (Pok, Wallace
et al. 2010). In brief, 30 mm X 10 mm rectangular strips were cut from each matrix and
strained to break at a constant crosshead speed of 10 mm/min using INSTRON 5842
(INSTRON Inc., Canton, MA). Using the associated software Merlin (INSTRON Inc.)
break stress and strain were determined. Samples were tested either in dry state at 25 °C
or in the wet state at 37 °C by immersing in PBS (pH=7.4) using a custom-built
environmental chamber. While testing at 37 °C, samples were immersed in PBS. The
elastic modulus was calculated from the slope of the linear portion (0.1% to 5% strain
range) of the stress-strain curve. To measure the thickness of the matrices, digital
micrographs were obtained at various locations through an inverted microscope (Nikon
TE2000U, Melville, NY) equipped with a CCD camera. These images were quantified
for the thickness using image analysis software Sigma Scan Pro (SPSS Science, Chicago,
IL), calibrated using a micrograph of a hemocytometer at the same magnification. Four
to five images were obtained per sample with at least ten points per image. The
calculated minimum thicknesses were used for determining the stress values in each

sample.

78



4.2.7. Degradation Characterization.

Degradation of the formed matrices was analyzed using the previously described
procedure with minor modifications (Sarasam, Krishnaswamy et al. 2006). In brief, 15
mm X15 mm samples were cut from each matrix, washed with deionized water, sterilized
in absolute alcohol for 30 minutes and washed thoroughly in sterile Krebs Henseleit
buffer solution prior to incubating in 10 mL Krebs Henseleit buffer solution (pH = 7.4).
Samples were placed in 20mL vials with a 15 mm diameter hole drilled in the caps and
covered on the inside with 0.45 um filters. Incubation was carried out in an incubator
maintained at 37°C and 5% CO,/95% Air. The media was replaced once every six days.

During the incubation pH of the buffer was also monitored.

At ten day intervals, three samples per group were retrieved for determining the
weight. Digital images of samples were also obtained to assess dimensional changes.
Collected samples were washed with deionized water, dehydrated using absolute alcohol
and briefly dried in a vacuum desiccator at ambient conditions prior to final weight

determination. Samples were also analyzed by SEM to characterize structural changes.

4.2.8. Statistical Analysis.

All cell culture experiments were repeated three or more times with quadruplicate
samples. All tensile testing were repeated four or more times and average and standard
deviations were calculated. Significant differences between two groups were evaluated
using a one way analysis of variance (ANOVA) with 99% confidence interval. When

P<0.01, the differences were considered to be statistically significant.
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4.3. Results.

4.3.1. Macroscopic Properties of Matrices.

Dispersion of PCL solution in water bath formed matrices quickly in 80 kDa and
46 kDa samples. However, 10 kDa PCL and mixture of 46 kDa and 10kDa PCL solutions
did not produce a stable matrix despite precipitation, suggesting that MW of PCL plays a
role in the matrix formation. Further, higher MW PCL solutions stored for more than
four days also showed no matrix formation, probably due to the acid hydrolyses
decreasing the MW of the polymer. Hence, all solutions were freshly prepared for
generating matrices. No further testing was done with the ratio of 10 kDa PCL and

mixture of 46 kDa and 10kDa PCL solutions.

Since temperature of water bath could influence matrix formation, other water
temperatures were tested apart from room temperature solution (~ 25 °C). Decreasing the
bath temperature to ~ 10 °C did not have a significant effect on the ease of formation of
the matrices. Interestingly, PCL solution froze at 4 °C (refrigerator) and the MW did
influence how fast the solution froze, probably due to freezing of acetic acid (melting

point=16 °C).

4.3.2. Surface Properties of Matrices.

First, we questioned whether there is any difference in the surface characteristics
of the side exposed to water-air interface (referred as top surface) compared to the side
submerged in water (referred as bottom surface). For this purpose, both sides were
evaluated by SEM. These results showed significant differences between the top side
(Figure 4.1) and the bottom side (Figure 4.2) of the matrices have different characteristic.
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Top side of all matrices showed porous structure, while the bottom side had rough
surfaces with significantly less number of pores. Top side of blended matrices had larger
pores compared to pure components. In addition, 1:0:1 blended matrix showed
perforations on the surface, and microdomains appeared like indentation on the top side.
This could be due to large difference in the chain size of the two molecular weights.
Matrices containing the intermediate MW PCL showed no microdomains in the top
surface. On the bottom side, 1:0:1 blended matrix showed a smooth surface compared to
all other compositions but no microdomains were observed. No significant differences

were observed between 0:1:0 and 1:1:1 blends.
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Figure 4.1. Surface morphology of the top sides of matrices. Scale bar corresponds to 50 pm.
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Figure 4.2. Surface morphology of the bottom sides of matrices. Scale bar corresponds to 50 um.
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4.3.3. Analysis of Surface Roughness.

The surface roughness was evaluated using AFM to better understand the effect of
blending different MW of PCL on the roughness of the bottom side of the matrices.
These results showed (Figures 4.3-A) a reduction in the surface roughness characteristics
with decreased MW; matrices formed with 1:0:0 showed the highest roughness.
Blending 10 kDa Mn PCL reduced roughness characteristics and presence of 46 kDa
showed an increase in roughness factor. Quantitative analysis of roughness factor
(Figures 4.3-C) confirmed statistically significant differences between 1:0:0 and 1:0:1
surfaces. This could be probably due to the packing of low MW PCL within the high

MW structure during self assembly.

4.3.4. Effect of NaOH Neutralization on Surface Roughness.

Prior to using the formed matrices in biomedical applications, reminiscent acetic
acid has to be removed. One option is to neutralize the surface with NaOH solution. To
assess the effect of alkaline solution on the surface of PCL, surface topographies were
analyzed by AFM. Neutralization process was carried out with 1N NaOH for 10 min.
These results (Figures 4.3-B) showed a significant difference between neutralized and
non-neutralized samples in 1:0:0 samples; non-neutralized 1:0:0 matrices had an average
roughness factor of ~160 nm and after neutralization, the roughness factor decreased to
~75 nm (Figures 4.3-C). Mixtures of different MW showed no significant effect of

neutralization process on the surface roughness, even in presence of 10 kDa PCL.
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Figure 4.3. Surface roughness characteristics. (A) Surface morphology of fresh matrices. (B) Surface morphology after

neutralization in NaOH. (C) Roughness changes in different blends.
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4.3.5. Effect on Cellular Activity.

Cell morphologies were evaluated to understand whether PCL matrices support
cell colonization. Cytoskeletal organization of HFF-1 was probed via actin staining.
These results (Figure 4.4) showed that HFFs PCL matrices had spindle shape, similar to
previous publications (Huang, Onyeri et al. 2005; Lawrence, Maase et al. 2008). HFFs
showed peripheral distribution of actin filaments, similar to cells on TCP surface.
However, there was a reduction in cell spreading characteristics relative to tissue culture
plastic. There was no significant difference in the cell spreading on different blended
matrices. Counterstaining with DAPI confirmed the presence of nuclei, along with the

actin fiber, suggesting that the PCL structure promotes cell attachment.

4.3.6. Surface Properties of Composite-layered Matrices.

Gelatin-chitosan composite scaffolds were attached to PCL matrices to improve
its bioactivity. These results showed (Figures 4.5) that the composite matrix was
attached on the both sides of 1:0:1 PCL matrix through the perforations. Since 1:0:1 PCL
sample had natural perforations by self assembly, gelatin-chitosan solution was
penetrated through the perforations and formed multilayer on PCL matrix. Multilayer
was not separated while the samples were neutralized in ethanol and incubated in PBS for
the mechanical test. This confirmed that gelatin-chitosan matrices were fastened through

the perforations of PCL matrix.
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Control

Figure 4.4. Effect of blending on the spreading of fibroblasts. Fluorescence

micrographs obtained after staining with actin and nucleus after 48 hrs of incubation.
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Figure 4.5. Effect of grafting gelatin-chitosan on porous stucture. (A) Photographs of gelatin-chitosan grafted 1:0:1 PCL matrix,
Micrographs of (B) gelatin-chitosan coated PCL (top view), and (C) gelatin-chitosan coated PCL (cross-sectional view).
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4.3.7. Effect on Tensile Properties.

Tensile properties were assessed in dry condition to understand the effect of
blending on mechanical characteristics. These results (Figure 4.6-A) showed a
significant decrease in the ultimate tensile stress of blended matrices; ultimate tensile
stress was 1 to 2 MPa for 1:0:1 blended matrix relative to 1:0:0 (80 kDa) matrices which
were in the range of 3 to 4 MPa. Further, strain range also decreased with blending; 1:0:1
blended matrix had 5 to 10% strain range whereas 1:0:0 (80 kDa) matrix had 320 to 370%

strain range.

When matrices were tested in hydrated conditions at 37°C (Figure 4.6-B),
ultimate tensile stress did not change significantly in both 80 kDa PCL and mixture.
However, tensile strain range increased remarkably in all the samples; 46 kDa PCL
showed the highest increase in the tensile strain. In addition, gelatin-chitosan coated
1:0:1 sample showed no differences in stress vs. strain curves and elastic modulus in both

conditions (Figures 4.6-A-C).

Elastic modulus was (Figure 4.6-C) calculated using the linear range (0.1%-5%).
These results showed that 80 kDa matrices had the highest modulus in both dry and wet
conditions. Elastic modulus was less in all the blended matrices relative to 80 kDa PCL,
suggesting an increase in the elastic properties of the matrix. In addition, elastic moduli
of all samples decreased in wet condition. This could be due to hydration of the

polymers in the wet condition.
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4.3.8. Effect on Degradation Characteristic.

Matrices were incubated in Krebs Henseleit buffer solution to understand the
effect of blending on degradation characteristics. These results showed that presence of
low MW PCL increased the degradation rate (Figure 4.7-A). Weight loss calculations
showed that 1:0:1 PCL matrices had 10% of weight loss after 50 days incubation. There
was no significant difference in the weight of 1:0:0 and 0:1:0 PCL matrices, confirming
that the weight loss is primarily due to 10 kDa Mn PCL. This suggests polymers were
present individually in the matrices without combining. However, pH of the incubation
medium did not change, probably due to the buffering capacity of Krebs Henseleit buffer,

unlike phosphate buffered saline.

When dimensions of the matrices were analyzed, no significant change in width
and length of formed matrices were observed. All matrices appeared intact during the
study period except 1:0:1 matrix (Figure 4.7-B), which ruptured around 50 days. Further,
1:0:1 matrix also showed an increase in number of holes in the matrix during 30 days.

This could correspond to the microdomains observed in the top side of the 1:0:1 matrix.

To understand the changes in surface architecture during degradation, samples
were analyzed by SEM. Since 1:0:1 sample showed significant differences, only those
samples were selected. These results showed no significant alteration during first ten
days in both top side and bottom side of the matrix (Figure 4.7-C). The surface features
were still present on both sides of the matrix. Generally, samples retrieved after thirty
days of incubation showed similar bottom side features as that of day zero samples.

Samples retrieved after fifty days showed similar top side features as that of day zero
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samples. This suggests that self assembled matrices of high MW PCL are stable despite
dissolution in acetic acid. Degradation was localized to the regions containing 10 kDa

PCL.
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Figure 4.7. Degradation characteristics. (A) Changes in the weight relative to day zero values. (B) Photographs of 1:0:1 samples at

different time points. (C) Micrographs of 1:0:1 samples at different time points. Scale bar corresponds to 50 um.
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4.3.9. Surface Properties of Anatomically Relevant Matrices.

Self assembly of PCL also occurred in tubular and spherical shapes on the solid
supports (Figure 4.8-A & D). However, one time self assembly was very thin and
porous, which caused difficulty in removing from the mold. Hence, three layers were
formed to improve the thickness. Since self assembly removes significant amount of
PCL from the solution and water becomes very acidic, every time fresh solutions were
used. If increased thickness is necessary, additional layers could be formed. Formed
pure 80kDa PCL matrices had no structural changes compared to 2-D matrix, where as
1:0:1 blended PCL matrices had a reduced number of perforations by multiple layering.
Further, layers could not be clearly identified by SEM, suggesting strong intermeshing of
new layers to the previous self assembled layers. Thus, mechanical failure due to weak
layer-by-layer interaction is not anticipated. However, these results (Figure 4.8) showed
that matrices of the anatomical structures had different surface characteristics relative to
2-D matrices. Both inside and outside surfaces of tubular shape matrices had the similar
surface characteristics (Figures 4.8-B & C) where as 2-D matrices had different surface
architectures between top and bottom side. In addition, matrices of spherical shape
showed non-porous structures outside of matrices where as inside of matrices had porous
structures without microdomains (Figures 4.8- E~F). These structural changes could be
attributed to 1) multiple layering and ii) contact with a solid surface rather air while

assembling.

94



Figure 4.8. Surface morphology of the 3-D scaffolds. (A) Photographs of tubular shape of 1:0:1 sample. Micrographs of (B)
outside of tubular shape, (C) inside of tubular shape, (D) photographs of bladder shape of 1:0:1 sample, (E) outside of bladder shape,
and (F) inside of bladder shape. Scale bar corresponds to 50 pum.
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4.4. Discussion.

Previously, we demonstrated the spontaneous aggregation of PCL dissolved in
acetic acid upon contact with water (Pok, Wallace et al. 2010). Formed PCL matrices
were hydrophilic as water uniformly distributed when added drop-wise onto the bottom
side of the dry matrix. Surface energy estimation of 80 kDa PCL matrices showed
different charge distribution on the bottom side of the PCL matrix. This facilitated
immobilization of gelatin via electrostatic interactions. Previous reports show that
dissolution of PCL in acetic acid does not alter the melting point and glass transition

temperature of PCL (Sarasam and Madihally 2005; Sarasam, Krishnaswamy et al. 2006).

This study explored the possibility of blending different molecular weights of
PCL and forming matrices in different shapes, suitable for tissue engineering applications.
Equal amounts of different molecular weights were blended and other blend ratios were
not investigated. Similar to 80 kDa, spontaneous aggregation of PCL into matrices was
observed upon contact with water. Although precipitation into self assembled matrices
did not occur with 10 kDa Mn PCL, blending 10 kDa Mn PCL with 80 kDa MW PCL
allowed formation of matrices. Blending the low MW PCL helps in regulating the
degradation rate. Nevertheless, one has to test the optimum ratio of low MW PCL to
high MW PCL since low MW PCL alone cannot form self assembled matrices and stable
structures by other methods such as electrospinning. Further, the same concept can be
adapted in other processing techniques such as electrospinning (Ghasemi-Mobarakeh,
Prabhakaran et al. 2008). Majority of the electrospun fibers for tissue engineering
applications are formed using high MW PCL. However, if degradation rates have to be

altered based on tissue type, then blending low MW is an option. In these studies, one
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has to assess the changes in surface properties and degradation behavior.

Surface analysis showed different morphology on both sides of the matrices.
Bottom side of the matrix had increased roughness relative to chloroform casted
membranes, probably due to the different aggregation mode as reported by others using
different solvents (Tang, Black et al. 2004). Top side had more perforations than bottom
side. We did not measure the alteration in surface charges with the addition of different
MW PCL. We speculate that the charge distribution will be similar to 80 kDa PCL

matrices.

When cellular activity was measured, cell spreading was significantly less
compared to tissue culture plastic surface. Since PCL alone does not have cell binding
domain, cellular attachment is probably due to serum proteins. To alter cellular activity,
blending natural polymers such as gelatin needs to be explored similar to previous studies.
Previously, cells adhered to self assembled PCL matrices in the absence of serum (Pok,
Wallace et al. 2010). Also, analysis of cellular activity needs to be extended to include

other types of cells and functionalities.

Measured tensile properties showed a reduction in ultimate tensile strength and
strain upon blending low MW PCL. These reductions could be due to the microdomains
observed in the surface, clearly visible in 80 kDa and 10 kDa mixtures. Similar domain
could exist in other blend combinations. Thus, while blending different molecular
weights, one has to consider the effect on mechanical properties. An option is making
thicker matrices which could have reduced pores on one side of the surface. Alternative

option to improve the distribution is by heat annealing or solvent annealing techniques.

97



These strategies have to be investigated.

Since porous structures are necessary for three-dimensional colonization of cells,
porous structures were generated using gelatin-chitosan combination. Previously, we
have shown that gelatin-chitosan- supports proliferation of many cell types including
fibroblasts and smooth muscle cells. There was no difficulty in distributing gelatin-
chitosan solution on to the self assembled PCL matrix. There was no need to perforate
the self-assembled PCL matrix while ensuring the adhesion of the porous structure,
unlike previously reported PLGA-based composite (Coombes, Rizzi et al. 2004). Further,
the uniform distribution of perforations in PCL matrix also showed less separation
between the gelatin-chitosan porous structures. It was observed that the entire composite
failed together during tensile tests, suggesting continuity between different phases.

Nevertheless, one has to test the tissue regeneration in these composite matrices.

In summary, blending different molecular weights to alter degradation
characteristics is an efficient approach which minimizes issues related to cross-linking
and presence of other functional groups. When matrices are generated by self assembly
in aqueous medium, roughness decreased in blended matrices. Surface roughness was
not altered in blended matrices after treatment with NaOH solution to neutralize acetic
acid. No significant alteration in cellular activity was observed. Further, tensile
properties also decreased by blending. Elastic modulus decreased with decreased MW,
validating the observed trend in compliance measurement. Significant alteration in
degradation rate was observed. Self assembled PCL matrices can be generated in
different shapes by using appropriate shapes. Gelatin-chitosan composite scaffolds were

attached to surface of blended PCL matrices and composite solution penetrated through
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the perforations. Freez-drying did not alter the tensile properties of self assembled PCL.
In summary, this self assembled PCL matrices show significant potential in tissue

engineering applications.
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CHAPTER V

BIOREACTOR DESIGN CONFIGURATIONS FOR

REGENERATING HUMAN BLADDER

5.1. Introduction.

Several approaches have been explored to colonize cells within a porous scaffold
necessary for in vitro tissue regeneration. Using traditional tissue culture plastic, porous
templates are inserted into wells and cells are seeded in a growth medium. However,
adapting the technique to thicker structures is limited by the diffusion of nutrients as the
primary mode of nutrient distribution within the porous structure is dictated by Fick’s
first law. The thickness of the tissue grown in static cultures is not comparable to that
necessary for transplantation. Bioreactors have been widely utilized to continuously
replenish the nutrients by convection (Gooch et al. 2001; Gray et al. 1988; Huang et al.
2005; Martin and Vermette 2005). In addition to improving the nutrient distribution,
fluid flow can also introduce shear force on the cells. This shear force stimulates cells
and alters the secretion characteristics which could affect the quality of the regenerated
tissue. Cells respond to stress by altering their ECM biosynthesis (Gooch et al. 2001) and

change the tissue composition (Chatzizisis et al. 2007; Cooper et al. 2007). Using
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various bioreactor designs, some studies reported an improvement in the quality of the
regenerated tissue (Niklason et al. 1999). However, other studies have reported
deterioration in the quality (Heydarkhan-Hagvall et al. 2006). Overall outcome of
regenerated tissue using bioreactors is of poor quality (Chen and Hu 2006; Martin et al.
2004; Niklason et al. 1999). This could be attributed to incomplete consideration of

reactor design.

A number of studies have been performed to model bioreactor fluid dynamics
(Brown and Meenan 2007; Cioffi et al. 2006; Hutmacher and Singh 2008; Porter et al.
2005; Sander and Nauman 2003; Williams et al. 2002). Simulations have simplified
mathematical models and reduced scaffold size due to increased computational demand
in simulating reactors suitable for clinical transplantation. Also, the kinetic models are
over-simplified by ignoring the mass and structural complexities. Further, tissue
regeneration is a dynamic process where the porous characteristics change due to matrix
deposition and tissue maturation. Assembly and maturation of ECM elements in tissue
regeneration play a significant role in determining the quality of the regenerated tissue.
These changes affect the transport characteristics and nutrient distribution. Also, in vitro
regeneration strategies are not characterized for high aspect ratio tissues which have large
surface area relative to the thickness (Heydarkhan-Hagvall et al. 2006). Among different
reactor configurations, the flow through reactor is better suited for regenerating high
aspect ratio tissues due to following advantages (Lawrence et al. 2009): (a) uniformly
supports or constrains the scaffold to prevent deformation, (b) continuous flow
replenishes the nutrients while providing better control on hydrodynamic shear stress

induced by the fluid flow, and (c) easy scaled-up to clinical requirement.
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Increasing computational capabilities and advances in the application of
numerical techniques has opened up possibilities to include complex transport steps in
modeling. Our laboratory previously reported on the analysis of fluid flow characteristics
along with nutrient distribution in growing tissues (Devarapalli et al. 2009; Lawrence et
al. 2009). We evaluated the effect of various factors including 1) reactor shapes
(rectangular, circular), ii) flow rate, ii1) inlet-outlet location, iv) inlet-outlet size which
regulate velocities, v) changing pore architecture, vi) nutrient consumption (particularly
oxygen and glucose) characteristics, and vii) different types of cells (smooth muscle cells,
chondrocytes, and hepatocytes) in flat bioreactor configurations. The bioreactor shape
and position of inlets and outlets affected to flow distribution and shear stress in high

aspect ratio reactors containing porous structures.

Many tissues in the body are three-dimensional in nature. In this study, we aimed
to simulate a bioreactor suitable for regenerating a human bladder by selecting
appropriate dimensions. Two different shapes of inlets were simulated to minimize shear
stress at the inlet area. Mimicking bladder shape of inlet was also tested. Within the
reactor, the importance of locating the porous structure was also evaluated in conditions

mimicking tissue regeneration i.e., changes in cell number and permeability.
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5.2. Materials and Methods.
5.2.1. Preparation of Porous Scaffolds.

1%-1% (wt/v) gelatin-chitosan, chitosan with 190-310 kDa MW and gelatin
Type-A (300 Bloom) were obtained from Sigma Aldrich Chemical Co. (St. Louis, MO),
solutions were prepared in 0.1M acetic acid using deionized water. A well of 10cm
diameter was prepared on Teflon dishes using silicon glue and 25mL of respective
solutions were poured in the well and frozen overnight at -80°C. The frozen solution was
lyophilized overnight (Virtis, Gardiner, NY). When porous scaffolds are formed by
lyophilization technique a thin non-porous film forms at the surface. This skinny layer
hinders access to the underlying porous structure if not removed. For removing the
skinny layer from scaffolds of 1%-1% (wt/v), a wet paper was placed on the top of the
solution once it was poured inside the well and frozen along with the solution. After
lyophilizing the paper was peeled off to generate scaffold without the skinny layer. Since
acetic acid remaining in the scaffold has to be removed, dried samples were first
incubated with pure ethanol for ten min and washed four times with phosphate buffered
saline (PBS). Wet samples were analyzed using an inverted microscope outfitted with a
CCD camera. Obtained digital micrographs were was analyzed using Sigma Scan Pro

software (Systat Software, Inc., Point Richmond. CA) for pore size and number of pores.
5.2.2. Bioreactor Designs.

The spherical shape of the bioreactor was designed for bladder tissue regeneration.
Based on the human bladder size, the volume of the reactor was set to 820 mL. The

volume of scaffold was chosen to be 755 mL with a thickness of 3 mm, similar to the
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human bladder.

Different inlet shapes. Simulations were performed in three different shapes of inlets to

assess shear stress distribution (Figure 1):

Design 1: Single cylindrical inlet and outlet with 28 mm high and 6 mm diameter at the

center of top and bottom of the reactor.

Design 2: Funnel shape inlet and outlet with 28 mm high, 6 mm diameter at the center of

top and bottom of the reactor.

Design 3: Double cylindrical inlet and single outlet with the same size of Design 1.

Different location of scaffolds: Since funnel shape inlet (Design 2) showed minimal
shear stress at the inlet area and uniform oxygen distribution throughout the reactor,
Design 2 was selected for further analysis. Three different locations of the scaffold

within the reactor were investigated using Design 2 (Figure 3):

Design 2-A: A 3-mm thick porous scaffold attached to the interior wall of the spherical
reactor. There was an additional 3mm open channel above the porous structure which
did not have any porous structure..

Design 2-B: A 3-mm thick porous structure was the annular region through which
medium was circulated.

Design 2-C: A 3-mm thick scaffold was suspended in the middle with 1.5 mm open

channel on either side.
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5.2.3. Fluid Flow Simulation.

The steady state analysis of the fluid flow was performed using the COMSOL
3.5a Multiphysics. Three dimensional (3D) reactor models were created by drawing
spheres of different radius in 3D (Geoml) and then using the “difference” tab in
COMSOL for getting the desired annular region. To add inlet and the outlet to this
annular region, a rectangular shape was drawn in 2D (Geom2) and then revolving it 360
degree along the axis. Next, the sub-domain and boundary conditions were set in the
Physics tab. The geometry was meshed one by one on all the edges using the constrained
edge element distribution in the free mesh parameters tab. Subsequently the surfaces and
the sub-domain were meshed using the triangular method and keeping the maximum
elemental size as 0.005. The number of mesh points was 12099~15673, and the number
of elements was 51417~68479. The flow rate was set at 0.5 mL/min initially. Then, the
flow rate was increased to 1 mL/min and then to 7.5 mL/min to determine the minimum
flow rate at which the nutrients were consumed fully. The simulation was performed
using the previously described procedure with modifications(Devarapalli, Lawrence et al.
2009), the velocity profiles were determined by solving a) the incompressible Navier —
Stokes equation on the non-porous regions and b) the Brinkman equation on the porous
regions. The nonporous sections of the reactor were modeled solving incompressible

Navier-Stokes equation which is given by
p(ueVyu=-Ve[-+pd, | (5.1

Veu=0 (5.2)

where u is the flow velocity (m/s), p is the fluid’s density (kg/m’), p is the pressure (Pa),
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5,]» is the Kronecker delta function. The Brinkman equation is given by

UV’u, —%uj_ =Vp (5.3)
Veu =0 (5.4)

where xis the permeability of the porous medium (m?), u; denotes the fluid superficial
velocity vector (m/s), p is the fluid pressure (Pa), and u is the effective viscosity in the
porous medium (kg/m.s). The permeability (&) of the porous medium is a geometric
characteristic of the porous structure at several length scales. Based on the pore
architecture of chitosan porous structures utilized in experimental analysis, the
permeability was calculated using an average pore size of 85 wm and 120 pores/mm? in

the equation (Truskey, Yuan et al. 2004)

K'Zil’lAd4 (5.5)

where n, is the number of pores per unit area and d is the average pore diameter. Both
the permeability (x; m?) and void fraction (¢, dimensionless) were incorporated into
Eq.(3) in order to account for the porous characteristics of the matrix, yielding another
form of the Brinkman equation (Truskey, Yuan et al. 2004) with the Navier-Stokes

equation.
%u =-V- [;—; + p(sij] (5.6)

where &, is the porosity of the porous media, taken as 85% based on the chitosan porous

structure characteristics. The shear stress was visualized as the viscous force per area in
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the z direction, as calculated by
ren (5.7)

The shear stress tensor is an integral part of the Navier-Stokes equations describing flow
in a free channel While solving the incompressible Navier-Stokes equations, the
perpendicular flow was given as 5 mL/min and the outlet boundary condition was set as

pressure = 0.

Since the nutrient consumption is governed by diffusion rather than convection, it
is important to accommodate the diffusive characteristics of nutrients through the porous
structure. The change in effective diffusivity (D.yin m?*/s) due to altered void fraction in
the porous structure is calculated using Mackie-Meares relationship (Mackie and Meares

1955; Mackie and Meares 1955; Sengers, van Donkelaar et al. 2005).

D =D, ( P )2 (5.8)

2-¢p

where D, is the diffusion coefficient from Stokes-Einstein equation, and @ is the porosity
of the scaffold. Velocity profiles in the scaffolds were obtained, and Peclet number was

calculated using the equation,
Pe=— (5.9)

where V' is the velocity, 7 is a radius of the scaffold, and Do, is the diffusion coefficient of

oxygen.
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5.2.4. Reactions in the Porous Structure.

Reactions in the porous region were simulated by the method previously
described(Devarapalli, Lawrence et al. 2009). Gelatin-chitosan scaffold was used for
porous structure with SMCs. Oxygen and glucose consumptions were simulated
independently for the reason that glucose concentration (5.5 moles/m’) in the growth
medium is in large excess relative to oxygen (0.2 moles/m’) concentration (determined
using the Henry’s law constant at 37°C). The rate constants were obtained for SMCs
based on the reaction rates reported in the literature (Motterlini, Kerger et al. 1998; Alpert,
Gruzman et al. 2002; Sengers, Heywood et al. 2005; Fogler 2006). Using the steady state
velocity profiles, the steady state concentration profiles of oxygen and glucose were
obtained by solving the equation of continuity using the chemical reaction engineering
module in COMSOL 3.5a Multiphysics. Nutrient consumption was included in the
simulation via the rate law. The convective diffusion equation was used to obtain the

concentration at varying position along the cross section of the reaction:
V- (=DVCy) +u-VCy =1y (5.10)

where ¢, is the concentration of the species (mol/m3 ), 74 1s the rate of reaction of the
species under consideration (mol/m’.s), D is the diffusivity of the species (m%/s), and u is
velocity vector (m/s). Physical properties of water were used as it constitutes the bulk of
the growth medium. The flow properties (i.e., viscosity and density) of the nutrient
stream depend on the properties of the bulk fluid. Since the cells are present only in the
porous scaffolds, nutrient consumption rate law was defined only in the porous region,

the reaction term was zero in the non-porous regions. It is a typical practice to decouple
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oxygen and glucose consumptions for the primary reason that glucose concentration (5.5
moles/m’) in the growth medium is in large excess relative to oxygen (0.20 moles/m”’)
concentration (the initial concentration of oxygen in the growth medium was determined
using the Henry’s law constant at 37°C for each cell type). In addition, for every mole of
glucose consumed, six moles of oxygen is consumed according to the stoichiometry of
aerobic metabolism. The rate constants were obtained for SMCs using Michaelis-Menten
type rate law based on the reaction rates reported in the literature (Motterlini, Kerger et al.
1998; Alpert, Gruzman et al. 2002; Sengers, Heywood et al. 2005; Fogler 2006). The

rate law is given by the expression

-1, (mol/m‘%.s):% (5.11)
m A

where 7, is the reaction rate, v,, is the maximum reaction rate, and %, is the Michaelis
constant. C, was replaced by c; for the oxygen concentration, and Cj is replaced by c,
for the glucose concentration. Both the rate laws were defined in the COMSOL to enable
the visualization of both the oxygen and glucose profiles within the porous structure.
Nutrient concentration profiles were obtained using “Slice Plot Parameter”, and the

minimum values were found using “Cross-Section Plot Parameters”.
5.2.5. Statistical Analysis

Significant differences between two groups (T-test) and more than two groups (F-
test) were evaluated using a one way analysis of variance (ANOVA) with 99%
confidence interval. When P<0.01, the differences were considered to be statistically

significant.
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5.3. Results.
5.3.1. Effect of Inlet shape on shear stress.

To minimize shear stress at the inlet area, three different shapes of inlets were
simulated. First, two different inlet shapes were simulated to evaluate shear stress
distribution at the inlet area of the porous structure. To mimic bladder configuration, two
inlets instead of one was also simulated. Based on our previous work (Devarapalli,

Lawrence et al. 2009), minimum volumetric flow rate of 0.5 mL/min was selected using

the relation _1‘02 - ZUACO2 / VR where Vy is the volume of the reactor and ACq,

medium concentration change at the outlet of the reactor. In Design 3, total volumetric
flow rate is same as the other two designs. In other words, each inlet had half the total
flow rate. Pressure drops through the reactor were simulated using Brinkman equation.
These results (Table 5.1) showed that no significant difference was observed in pressure
drop with different inlet shapes. Even though Design 3 had a half flow rate in each inlet,
its pressure drop was similar to Design 2. Maximum shear stress at the inlet area of the
scaffold was also evaluated. Maximum shear stresses of three designs increased
constantly with increasing flow rate. However, Design 2 showed less increase in shear
stress by increasing flow rate compared to Design 1 and 3. Maximum shear stress of
Design 2 was ~161 pPa at 5 mL/min of flow rate where as Design 1 had 1160 pPa.
Design 2 provided the uniform shear stress at the inlet while uniformly distributing
sufficient amount of nutrients. This resulted in reduction in the shear stress at the wider
inlet of Design 2 (Figure 5.1). In addition, the maximum shear stress and pressure drop

of Design 3 was similar to Design 2 (Table 5.1).
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The effect of different inlet shapes on nutrient distribution was also evaluated.
This result (Figure 5.2) showed that Design 1 and 2 had uniform distribution of oxygen
through the bioreactor. However, Design 3 had reduction of oxygen concentration at the
outlet area with non-uniform oxygen distribution because of two inlet flow from different
directions. Since results of the pressure drop, shear stress, and nutrient distribution
analysis showed that design 2 had the most favorable configuration, Design 2 was

selected for further analysis in presence of porous.

Table 5.1. Effects of inlet shapes and flow rate on pressure drop through the

reactor and shear stress at the inlet area.

Design 1 Design 2 Design 3

Max. Max. Max.
Flow Rate Ap Shear Ap Shear Ap Shear
(mL/min) (mPa) Stress (mPa) Stress (mPa) Stress
(nPa) (nPa) (nPa)

0.5 12.07 44 8.32 17 8.22 31

1 24.19 99 16.73 35 16.56 64

5 127.55 1160 90.56 161 88.85 405
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Figure 5.1. Shear stress distribution with different shapes of inlet. (a) cylindrical shape inlet, (b) funnel shape inlet, and (c) two
cylindrical shape inlets.
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Figure 5.2. Oxygen distribution through the reactor with different shapes of inlet. (a) cylindrical shape inlet, (b) funnel shape

inlet, and (c) two cylindrical shape inlets.
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5.3.2. Effect of Location of the Scaffold on Velocity Profile.

Next, Oxygen mass transfer can be simply described as the movement of the
molecule relatively to fixed references due to two main contributions: diffusion and
convective flow(Martin and Vermette 2005). Based on this concept, three different
locations of the scaffold within the reactor were investigated using Design 2 (Figure 5.3.
a-c); i) Design 2-A: fluid flow within the scaffold occurred by diffusion, ii) Design 2-B:
convective limited, and iii) Design 2-C: both diffusion and convection. Velocity profile
within the scaffold was found using “Cross-Section Plot Parameters” with 5 mL/min of
volumetric flow rate. These results showed (Table 5.2 and Figure 5.4) that reduced
channel size with the same volumetric flow rate increases velocity. Design 2-B which
has no channel between the reactor and porous structure had a higher average velocity
(69000 mm/s) than Design 2-A (38 mm/s) and Design 2-C (82 mm/s). Further, velocity
profile indicated that Design 2-C was the most favorable configuration with very low
velocities across the scaffold. However, Design 2-A showed that the velocity reduced by

reaching the inside wall of scaffold, and the velocity was zero at the end of scaffold.

In addition, the average Péclet number was calculated in the porous area using the
equation 9. The velocity at the center of scaffold was used to calculate Péclet number
with 1.1937%10”° m?/s of diffusivity of oxygen. These results showed that Design 2-A
and C had Péclet number of less than 1 where as design 2-B had ~170 of dimensionless
Péclet number (data was not shown). This suggested that Design-2 A and C had

diffusion dominant characteristics where as Design 2-C was convective flow dominant.
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Figure 5.3. Designs of bioreactors with different location of scaffold.
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Table 5.2. Effects of location of scaffold on peclet number and average velocity
through the scaffold. Note that volumetric flow rate was 5 mL/min

Peclet No. Average Velocity
(mm/s)
Design 2-A 0.096 38
Design 2-B 173.411 69000
Design 2-C 0.206 82
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Figure 5.4. Velocity profile through the scaffold.
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5.3.3. Effect of Location of the Scaffold and Flow rate on Pressure Drop and Shear
Stress.

Pressure drop through the bioreactor and shear stress within the scaffold were
analyzed with different scaffold locations and flow rates. Since pressure drop and shear
stress were calculated by Brinkman equation, these values were not a function of the rate
constants of SMCs. These results showed (Table 5.3) that pressure drop was increased
by increasing the flow rate from 0.5 mL/min to 5 mL/min, and Design 2-B had the
highest pressure drop compared to others.

Maximum shear stress ranges through the porous structure were evaluated using
“Domain Plot Parameters” and “Surface” function. Since shear stresses at the inlet area
were minimized from earlier simulation, shear stresses of inlet area were neglected.
Maximum shear stresses showed a linear increase with increasing the flow rate (Table
5.3). Design 2-C showed a higher shear stress range relative to other designs. Maximum
shear stress range of Design 2-A was 45~58 uPa, 90~200 uPa was for Design 2-B, and

Design 2-C had 150~230 pPa. However, those values did not have significant difference.
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Table 5.3. Effect of location of scaffold and flow rate on pressure drop through the

reactor and shear stress through the scaffold.

Design 2-A Design 2-B Design 2-C

0.5 8.32 4.5~6 10622 9~20 20.72 15~23
5 90.56 45~58 106255 90~200 214.15 150~230
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5.3.4. Oxygen and Glucose Concentration Profile at the Steady State.

To evaluate the effect of location of scaffold on nutrient consumptions of oxygen
and glucose, simulations were performed with defined rate laws for smooth muscle cells.
The simulations were performed at the same cell density (1.2x10'? cells/m’). Nutrient
concentration profiles were obtained using “Slice Plot Parameter”, and the minimum
values were found using “Cross-Section Plot Parameters”. Most of minimum nutrient
concentration was found at the outlet area of the porous structure. These results showed
(Table 5.4 and Figure 5.5) that the location of the scaffold did not affect significantly to
both minimum and outlet oxygen concentration at the low flow rate. Design 2-A showed
a higher concentration with 0.5 mL/min of flow rate than Design 2-B and C. However,
Design 2-B and C had higher minimum oxygen concentration at the higher flow rate than
Design 2-A. In other words, Design 2-B and C showed a sharp increase of minimum
oxygen concentration followed by increase of flow rate, whereas Design 2-A had a
gradual increase. In addition, there was no significant difference in glucose consumption
for three designs with lower flow rate. Along with a result of oxygen concentration,
Design 2-B and C had a higher glucose concentration than Design 2-C. However, no
significant difference was observed in glucose consumption by varying flow rate and
location of scaffold.

Results of “Cross-Section Plot Parameters” analysis confirmed that oxygen
distribution of three designs did not indicate significant differences at lower flow rates.
Further, Design 2-B and C through the reactor and porous structure was fully saturated
with oxygen by reaching at 5 mL/min of flow rate. Glucose was also highly saturated in

every design (Figure 5.6-5.7).
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Table 5.4. Effect of location of scaffold and flow rate on oxygen and glucose distributions.

Design 2-A Design 2-B Design 2-C

0.5 0.0352 0.0696 4.362 0.0274 0.0449 4.628 0.0262 0.0557 4.379

5 0.1076 0.1828 4.868 0.1553 0.1770 5.227 0.1314 0.1819 5.224
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Figure 5.5. Effects of location of scaffold and flow rate on (a) oxygen concentration profile, and (b) glucose concentration profile.
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Figure 5.6. Effects of location of scaffold and flow rate on oxygen concentration profile.
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Figure 5.7. Effects of location of scaffold and flow rate on glucose concentration profile.
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5.3.5. Effect of Cell Density and Permeability on Nutrients Consumption.

Since cells grow and populate through the scaffold, the number of cells can be
increased or permeability of porous structure can be reduced by proliferation of cells
without differentiation. To understand the effect of varying cell density and permeability
on nutrient consumption, pressure drop, and shear stress, simulations were performed by
increasing initial cell seeding density of SMCs or decreasing permeability. The flow rate
was fixed with 5 mL/min. These results showed (Table 5.5) that minimum oxygen
concentration reduced significantly with decreasing permeability at the constant cell
number. Slice plot results for Design 2-C (Figure 5.8-A) also confirmed that insufficient
oxygen concentration regions were observed within the porous structure with
permeability of 4.7 um®. This result suggested that increasing the flow rate is necessary
to adjust requirements to the cell proliferation. In addition, pressure drop of Design 2-A
& C were increased slightly by reducing permeability where as design 2-B showed an
increase of pressure drop. However, shear stress was not changed significantly by
reducing permeability (data was not shown). This suggested that pressure and flow rate

should be adjusted by decreasing permeability.

The number of cells was varied to evaluate the effect of cell density with constant
permeability. These results showed (Table 5.5 and Figure 5.8-B) that minimum oxygen
concentration decreased by increasing cell density of SMCs while outlet oxygen
concentration decreased. Shear stresses were not altered significantly by increasing cell
density at the constant permeability. Further, optimum flow rates for Design 2-C were
evaluated to maintain the minimum oxygen concentration of 0.05 mol/m’ followed by

increasing cell density (Figure 5.9). The smooth muscle cell density of the human
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bladder was calculated from the literature review. The number of cells was increased

until it exceeds typical SMCs density of 1.3 * 10" cells/m”.
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Table 5.5. Effects of varying cell density and changes in permeability on oxygen consumption rate.

Design 2-A Design 2-B Design 2-C

1x 85 154 90.56 0.1076 0.1828 106255 0.1553  0.1770  214.15 0.1314 0.1819

1x 20 4.7 90.58 -0.0352 0.1944 34611082 -0.4448  0.1782  232.85  -0.0424 0.1939

4x 85 154 90.56 0.0226 0.1550 106255 0.0622  0.1198  214.15 0.0759 0.1368
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(a) Permeability (pum?)

0.12 0.08 0.04

(b) Number of Cells (1.2*%10*2 cells/m?3)

Figure 5.8. Effects of permeability and cell density on oxygen distribution. Note

that volumetric flow rate was 5 mL/min.
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5.4. Discussion.

Bladder contains a large number of SMCs and few layers of UCs. Static cultures
relying on Fickian diffusion for distribution of nutrients cannot support the growth of
thicker (>0.5-1.0 mm) tissues. Fluid is constantly replenished by recirculating in the
porous structures to improve nutrients distribution by convection. Bioreactors of
different configurations are explored for in vitro tissue regeneration, although no reactors
are designed to support co-culturing of two cell types (Walther 2002; Martin, Wendt et al.
2004; Martin and Vermette 2005; Marolt, Augst et al. 2006; Cummings and Waters
2007). A popular design is a rotating reactor with simulated microgravity (Williams,
Saini et al. 2002). However, these reactors are unsuitable for growing large thin bladder
tissues as rotary motion tumbles and distorts the structure. Since, hydrodynamic shear
force influences cellular alignment (Huang, Onyeri et al. 2005; Waters, Cummings et al.
20006) in the flow direction (Gray, Pizzanelli et al. 1988; Takahashi and Berk 1996;
Huang, Onyeri et al. 2005), fluid path helps align the cell in the required direction.
However, cellular constructs grown under hydrodynamic force shrink, due to suboptimal
fluid flow, scaffold compression, premature washout of the de novo synthesized matrix
elements prior to complete assembly, and cellular attachment and contraction. There is a
need to understand the fluid flow characteristics within the bioreactor and evaluate the

effect of the structure.

This study focused on understanding on the shapes of inlets, the location of
scaffold, and what controls nutrient distribution with different conditions for large scale
of tissue regeneration. Gelatin-chitosan system was selected as the model system for the

following reasons: 1) a significant work exist with chitosan-based tissue scaffolds i1) more
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is known about its chemistry, degradation, iii) and host tissue response than most other
tissue scaffolds. Scaffold degradation is enzyme-mediated. Hence, the dynamic changes
in the porous scaffold due to degradation can be ignored in the absence of enzymes
during the initial study period. Further, one could systematically study the role of
degradation by adding enzymes and their reaction kinetics. The porosity and pore size
distribution of these scaffolds in hydrated condition has been extensively characterized in
our laboratory (Huang, Onyeri et al. 2005; Huang, Siewe et al. 2006; Tillman, Ullm et al.
2006). This combination promotes cell adhesion and increased secretion of ECM
components in static cultures with very slow cell growth. Hence one could assess the

effect of ECM maturation without considering dynamic changes in cell number.

Since it is widely known that cells respond to hydrodynamic shear stress,
evaluation of optimized shear stress is essential for the design of bioreactors. In this
study, shear stress at the inlet area was minimized by increase the size of connected area
of inlet and reactor. Funnel shape inlet (Design 2) dispersed initial inlet flow, and
showed a uniform distribution of shear stress through the scaffold. Maximum shear
stress of Design 2 was significantly lower compared to Design 1 and Design 3. This
could be attributed to the funnel shaped entrance, which provides a smooth expansion
instead of sudden expansion of the fluid at the inlet, minimizing significant variation in
shear stress. Minimized shear stress can give an advantage to increase flow rate, in case

of insufficient nutrients consumptions.

Since nutrient transfer can be explained with diffusion and convective flow and
their dominants can be changed by the location of scaffold and channel size in the reactor,

three different types of designs were simulated to evaluate the effects on flow mechanism,
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pressure drop, shear stress, and nutrients distribution. Diffusion or convection dominants
were assessed by determining Peclet number. Design 2-A and C had Peclet number of
less than 1 where as Design 2-B had Peclet number greater than 1. Especially, Design 2-
C, fluid flow was occurred by both diffusion and convection, showed a shape increase of
minimum nutrients concentrations by increasing flow rate rather than others. Hence, we
could extend the current simulation results to include a 150-200 pm region with
urothelial cell (UC) consumption kinetics. The flow through the UC layer should not be
a significant factor as 1) free diffusion is sufficient to distribute the nutrients without the

need of convective flow and ii) Design 2-C can be adapted for this purpose.

To consider the changes in effective diffusivity with permeability, it was
calculated for various void fractions using Mackie-Meares model (Mackie and Meares
1955; Mackie and Meares 1955; Sengers, van Donkelaar et al. 2005), which describes the
diffusion of electrolytes in a resin membrane. Mackie-Meares model is based on the
lattice model for liquids and assumes that the polymer fibers are of the same size as the
solutes and the polymer network only blocks the pathway of solutes without affecting
their mobility. Although Mackie-Meares model is shown to agree for a variety of
conditions, it underestimates diffusivities with higher solute concentrations (based on
water as the solvent) (Lai, Koseoglu et al. 2009). Mackie-Meares model ignores
polymer-solute interactions such as adsorption effects. Thus, obtaining a better
estimation of diffusivities and validating the Mackie-Meares model predictions is
important. Further, structural changes due to fluid flow alter the nutrient distribution due

to altered local convective flow and diffusivity.

Inner wall of the bladder is made up of 150-200 pum thick urothelial cells.
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Bioreactor should allow regeneration of UCs for successful regeneration of bladder tissue.
Design 2-C is ideally suited for this purpose. We could extend the current simulation
results to include a with urothelial cell consumption kinetics. The flow through the UC
layer should not be a significant factor as free diffusion is sufficient to distribute the
nutrients without the need of convective flow. Nevertheless, these conditions need to be
validated experimentally in presence of cells to determine whether those minimum flow
rates are sufficient to ensure nutrient distribution. In addition, one has to determine the
effect of flow rate on the quality of the regenerated tissue. Increased flow rate increases
the shear stress in the microenvironment which could wash away de novo synthesized
ECM components or alter cellular responses deleteriously. These changes could lead to
poor quality of the regenerated tissue. Further, one has to generate 3D porous structure
mimicking bladder shape, rather than suturing flat matrixes into a bowl-shape, which
reduce the quality of the regenerated tissue due to the problems associated with the

wrinkles (varied thickness) in the matrix (Atala, Bauer et al. 2006).

In summary, the new funnel shape of inlet decreased shear stress at the inlet area,
and it showed uniform distribution of shear stress through the porous structure. The
location of porous structure within the reactor affected to hydrodynamic forces and
nutrient distributions significantly. Bioreactor with suspended porous structure in the
middle with open flow area on either side had less pressure drop and shear stress
distribution with retaining sufficient nutrients distribution. In addition, it is necessary for
altering the volumetric flow rate and pressure to maintain constant nutrient distribution

followed by cell proliferation and matrix deposition.
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CHAPTER VI

CONCLUSIONS AND RECOMMENDATIONS

6.1. Conclusions.

6.1.1. Characterization of a novel method to make scaffolds using the synthetic

polymer polycaprolactone (PCL).

A novel process of dissolving PCL in acetic acid which allows spontaneous
aggregation of PCL upon contacting with the water was investigated to develop a
biocompatibility and environment friendly process. 80 kDa Mn PCL matrices formed
from self assembly method were compared with chloroform-cast matrices (conventional
method) to evaluate the effect of different solvents on the surface morphology and
characteristics, effect of neutralization process, tensile properties, stress relaxation

properties, and cellular activity.

The results showed that PCL matrices can be generated using the novel technique
in aqueous media. Self-assembled matrices had rough and porous structures where as
chloroform-cast matrices had smooth and non-porous surface characteristics. Self-
assembled matrices showed an increase in roughness, which decreased after the
neutralization process in NaOH solution. Measured tensile properties showed a reduction

in elastic modulus but with similar stress relaxation behavior relative to chloroform—
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casted matrices. Stress relaxation experiments showed less accumulation of stress in self-
assembled matrices relative to chloroform—cast materials. A significant difference
between self-assembled matrix and chloroform—cast matrix was a relaxation during the
loading phase of chloroform—cast matrix. This was not observed in self-assembled
matrices, which could be attributed to alteration in the packing pattern of the polymeric

chains.

When cellular activity was measured, increased cell adhesion was observed on
self-assembled matrices with a similar cell spreading to TCP. Thus the new simple
technique shows an improvement in cellular interactions. Since matrix topography affects
cell spreading characteristics, the observed variation in cellular activity could be
attributed to the significant increase roughness. However, the number of cells attached to
the matrix reduced significantly compared to TCP. Hence, immobilizing with naturally

derived polymers was necessary to enhance cell adhesion with better control of pore size.

6.1.2. Effect of blending different molecular weight of PCL and multi-layered

scaffolds on biological properties.

Self assembled PCL matrices needed an improvement in an ability to control
degradation rate and cellular activity while sustaining suitable mechanical properties.
Since degradability of PCL depends on its molecular weight, low molecular weights of
PCL (47 and 10 kDa Mn) were blended and matrices were formed using the self
assembly method. Further, gelatin-chitosan composite was hybridized to improve porous

structure and to promote better cell adhesion.
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Pure 10 kDa PCL was not formed a matrix, probably due to the lack of stable
interpenetrating network formation. No significant differences in surface morphology
and degradation characteristics were observed in between pure 80 kDa, 47 kDa, and
mixtures of 80, 47, 10 kDa PCL matrices. The blended matrix of 80 and 10 kDa showed
a distinguishable surface characteristic with perforations and larger pore size.
Furthermore, percentages of weight loss was decreased significantly compared to others,
due to the presence of low MW (10 kDa Mn) PCL. Although tensile properties decreased
by 10 kDa PCL, comparing results with currently used materials showed suitable
mechanical properties for tissue regeneration applications. The blended matrix of 80 and
10 kDa was used for further steps. The porous scaffold of chitosan-gelatin is known to

support cell colonization.

Gelatin-chitosan composite scaffolds were sandwiched with PCL matrix, and
formed multi-layered scaffolds. Gelatin-chitosan matrix was attached on the surface of
PCL matrix and fastened through the perforations. There was no significant effect of
multi layering on mechanical properties. In addition, the bladder and the blood vessel

shapes of porous scaffold were formed by self assembly and multi-layering.

6.1.3. Design of a bioreactor for bladder tissue regeneration using computational

fluid dynamic.

A bladder shape of scaffold was mimicked by self assembly and multi-layered
scaffolds. Cell cultivation systems for large and 3-D scaffolds mimicking bladder shape
have not been investigated yet. In this aim, fluid dynamics of the bioreactors for the

bladder tissue regeneration were simulated using COMSOL multiphysics.
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The bioreactor with an average volume size of human bladder was designed and
simulated. These results showed that the funnel shape of inlet minimized the shear stress
at the inlet area, and generated a uniform shear stress throughout the porous structure.
Two inlets mimicked bladder configuration was also simulated. The shear stress at the
inlet was decreased by splitting volumetric flow rate into two inlets. However, two inlet
flows indicated non-uniform nutrient distributions through the bioreactor. Hence one

funnel shape inlet was selected further investigations.

The location of porous structure within the reactor affected hydrodynamic forces
and nutrient distributions significantly. Bioreactor with suspended porous structure in the
middle with open flow area on either side had less pressure drop and shear stress
distribution with retaining sufficient nutrients distribution. This result proved that
nutrient transfer can be explained by diffusion and convection dominants by calculating
Peclet number, and the diffusion dominant flow system with less convective effect had a

better environment through the reactor and cell seeded scaffold.

Since cells grow and populate through the scaffold, the number of cells can be
increased or permeability of porous structure can be reduced by proliferation of cells or
matrix deposition. These results showed that the novel bioreactor provided sufficient
nutrients for increased cell number, and there are no significant changes in the pressure
drop and the shear stress. However, the volumetric flow rate and pressure need to be
altered by decreasing permeability to maintain constant nutrient distribution. These
results can be used as a criterion while developing bioreactors for the regeneration of

human bladder.

142



6.2. Recommendations.

In this study, novel processing of the PCL matrix formation was characterized for
suitability in tissue engineering. A significant advantage of this novel method is an
easiness of forming scaffolds into desirable shapes and sizes. I focused on developing
the methodology for the bladder tissue regeneration. However, there are many other
applications such as vascular grafts in which this technique could be utilized. Further, a
novel bioreactor configuration was designed and simulated to find optimized
environments for a bladder tissue regeneration system. To see those studies for

usefulness in clinical applications, several aspects need to be further evaluated.

6.2.1. Comparing scaffold characteristics with natural tissues.

The stress and relaxation property of self assemble matrices was analyzed. The
relaxation during the loading phase was not observed in self-assembled matrices.
However, one has to perform experiments with varying loading and relaxation times to
better understand the viscoelastic behavior significantly depends on the loading and
relaxation times. These results need to be considered compared to materials used, since
different types of applications require different viscoelasticity. Further, one has to test

the effect of temperature on the viscoelastic behavior.

Blending with low MW of PCL has indicated that the degradation rate was
increased and they had a unique surface characteristic. However, this blended PCL had
the same amount of PCL in each MW. Since the presence of more amounts of low MW
PCL can affect or change its properties, one has to assess the effects of different ratio of

blending on surface characteristics, mechanical strength, and biological properties.
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In addition, effects of neutralization process in NaOH solution and blending
different MW of PCL on the surface roughness factors were analyzed, and the results
indicated the possibility of the control of the roughness factors. Most types of cells have
their own desirable surface morphologies such as specific ranges of the roughness factor
and the pore size (Nehrer, Breinan et al. 1997; Salem, Stevens et al. 2002). In this study,
only HFF-1 cells were seeded, and their survivability was mainly focused. Hence, it is
necessary to test the effects of different surface morphology characteristics of self

assembled PCL matrices on different types of cellular activities.

6.2.2. Effects of Different Cell types and Kinetics.

In this study, cell adhesion and spreading were characterized on synthesized
surfaces. Detailed cell colonization studies, such as growth characteristics and alteration
in secretion of matrix elements such as collagen, elastin, proteoglycans, have to be
analyzed extensively. In addition, cellular activity of other cell types needs to be
performed. These findings open new possibilities to understand the influence of charge
and roughness separately on macromolecular interactions and cell colonization, which

has not been well understood in tissue regeneration.

Further, the kinetic parameters used in bioreactor simulation for nutrient
consumption were obtained from the literature on tissue culture plastic condition
(Motterlini, Kerger et al. 1998; Alpert, Gruzman et al. 2002). To improve the simulation,
nutrient utilization constants for oxygen and glucose have to be evaluated in porous

structure. Hence, detailed analysis of cell colonization should include nutrient kinetics as
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well as secretion of matrix elements. One has to obtain the cell kinetic data of 3-D

porous media to have better predictions in the bioreactor simulation.

6.2.3. Multiple Cell Lines of Bladder.

The human urinary bladder has a multilayer asymmetric architecture which means
that the bladder has multi-cell lines consist of smooth muscle cells (SMCs) layer,
urothelial cells layer, and extracellular components (Wallis, Yeger et al. 2008). In this
study, only SMCs were seeded on the scaffold since SMCs layer consists of the most part
of bladder layers, and urothelial cells layer has a thickness of 200 um. Hence it was
assumed that sufficient nutrients can be transferred by the diffusion. However, to
consider reality, one has to simulate a co-culturing system which has two different inlet

flows for the outer surface of scaffold and the inner surface of scaffold.
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APPENDIX

APPENDIX A: COMSOL Multiphysics 3.5a

A.1. Creating Geometry.

1. Start > All Programs > COMSOL 3.5 a > Click on COMSOL Multiphysics 3.5.a

2. In Model Navigator > Set Space Dimension as 3D.

3. In the Application Modes section, click on Chemical Engineering Module > Fluid

Chemical Reaction Interaction > Reacting Flow > Select Steady State Analysis

4. In the Dependent Variables tab, type cl and c2 > Click Add > OK.

\® Model Navigator
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5. In the Menu bar go to File > Save. And save the file with a desired name, e.g.

Bladder reactor design 1.

6. In the Menu bar go to Draw > Select Sphere > Set the radius as 5.5cm radius (SPH1)
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7. Repeat step 5, Draw spheres with 5.35 (SPH2) and 5.2 c¢m radius (SPH3)

8. Select SPH1 and SPH2 > click Difference tab to get the annular region between two

sphere.

9. Repeat Step 7 for the SPH3
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10. In the Menu bar go to Multiphysics > Model Navigator > Click Add Geometry >

Set Space dimension as 2D > click OK.

11. For inserting the funnel shape inlet and outlet, Click Geom2 > Draw lines shown in

the figure below.
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12. In the Menu bar go to Draw > Revolve > Set a2 degree as 360°

13. To unify Geometry 1 and 2, Select sphere, inlet, and outlet > In the Menu bar go to

Draw > Create Composite Object > Unclick Keep interior boundaries > Click OK.
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A.2. Meshing Geometry.

1. In the Menu bar go to Mesh > Free Mesh Parameter > Edge > Distribution > Set

Number of edge elements accordingly > Click Mesh Selected > OK.

2. In the Menu bar go to Mesh > Free Mesh Parameter > Boundary > Distribution >

Set Maximum element size accordingly > Click Mesh Selected > OK.
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A.3. Building Constants.

1. In the Menu bar go to Options > Constants > Build constants library > OK.

Expression V3l Description
lc':':(‘;]-"‘ i 3] lc(-.qllQr'ﬂ'! sl y
0.0006915(N"s/m"2] (6.9152-4) dynamic Gscosity
-2.947*10"-4{m/s) -2.947e-4[rvelodity
1.53744*10"-10({m*2) (1.53744¢- parmeabily
4.862*10~-S{mol/{m"3"s)) (4.862e-5)

0.93(molfm~3) 0.93{molje
3.164%10~-S{mali(m~3°s)] (3.164-5)
0.205{ moljen"3) 0.205{ moljr

=2

2. There are four columns; Name, Expression, Value, and Description. In the name

column, type the name of parameters.

Description

rho kg/m
Dynamic viscosity eta N*s/m”
Velocity Wo m/s
Permeability K m’
Reaction rate \Y mol/m’*s
Michaelis constant Km mol/m’
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A.4. Building Subdomain and Boundary Conditions.

1. Select Incompressible Navier-Stokes > in the Menu bar go to Physics > Subdomain

Setting.

2. Express density, dynamic viscosity, and permeability for both porous and nonporous

> Set Porosity as 0.85 (85%) > Click OK.

Subdomain Settings - Incompressible Navier-Stokes (chns) &
I Equations
(nik+Qlu = V{-pI + (1/e Hn({Vu + (vu)7) - (2n/3- Ky VU] +F
Vu=Qlp
Subdomains | Groups Physics [ 1nit | Element |
Subdomain selection Fluid properties and sources/sinks
1 - Library material: v ! [ Load...
' z 2
3 (monporous) Quantity Value/Expression Unit Description
P tho kgim®  Density
n eta Pas Dynamic viscosity
K4y 10 Pa:s Dilatational viscosity
FFol Nfm? Volume Force, x dir.
Fy 0 Njm®  Volume force, y dr.
F, b Njm? Volume force, z dir.
L >} ¥ Flow in porous media (Brinkman equations)
Group: OUs
U L a 5, [oss Porosity
|| Selact by group " K me Permeability
7| Active in this domain qQ 0o kgl{m?.s) Source term
Ok | [ cancel |[ apply |[ Hep
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3. Select Incompressible Navier-Stokes > in the Menu bar go to Physics > Boundary

Setting.

4. Select inlet area in the geometry > Set Boundary type as Inlet > Set x- and y-velocity

as zero > Set z-velocity as w0.

5. Select outlet area in the geometry > Set Boundary type as Outlet > Select Pressure

and set PO to zero > OK.

Boundary Settings - Incompressible Navier-Stokes (chns) i
Equation
u=u,
[ Boundaries .Gfu_ps: | Coefficients | _
Boundary selection Boundary conditions
20 A Boundary type: ‘Inlet =
21 -
2 Boundary condgtion: Velocity v
23 Quantity  Value/Expression Unit Description
E; 2 Y 0 mis  x-velocty
% Yo 0 mis  y-velocty
29 Yy 1 mfs  Normal inflow velocity
30
35
A ad
Group:
[7] Select by group
| Interior boundaries
[ ok ][ caxel |[ aply |[ Heb |

6. Select Convection and Diffusion > in the Menu bar go to Physics > Subdomain

Setting.
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7. Set Diffusion coefficient for oxygen (c1) and glucose (c2)and Michaelis-Menten

equation to calculate reaction rate in the porous region.

Subdomain Settings - Convection and Diffusion (chcd) g =)
Equation

V{-DVcl) =R - u-Vcl, cl = concentration

Subdomains | Groups| [t [ ca [ 1nit | Element
| | Subdomain selection Species 1
1 (nonporous) A Library material: | ~| [ Load...
' -
3 (nonporous) Quantity Value/Expression Unit Description
@ D (icotropic) 1.1937€-00 méls Diffusion coafficient
D (anisotropic) 100010001 ms Diffusion coefficient
R -V_o*c1/(Km_o+c1) | molf(m*.s) Reaction rate
X u u ms x-velocity
Group: | porous - v v mjs w-velocity
] Selact by group w w m/s z-velocity

[¥] Active in this domain |  Artificial Diffusion...

(o ) ([ concel ][ appty ][ heo ]

8. Select Convection and Diffusion > in the Menu bar go to Physics > Boundary

Setting.

9. Set initial concentrations for oxygen (c1) and glucose (¢2).

Boundary Settings - Convection and Diffusion (chcd) A

Equation

[c1 [
Boundary conditions
Boundary condtion: | Concentration

-

Quantity Value /Expression Unit Description

cly 0.199 molfm®  Concentration

Ng 0 mol/(m?.s) Inward Flux

D mfs Diffusion coefficient
il d 1 m Thickness
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A.S. Solving Parameters.

1. In the Menu bar go to Solve > Solve Parameter > Set Linear system solver as

Direct (PARDISO) > Click OK.

Sobver Parameters

Anabyis types

Incompressible Navier-Stokes (chns

o T,
Convechon and Difuscon (ched)
Stabonary -

¥ Auto select schver
Sobver

Time dependent

Exgary shue

Par smetric

Statonary seqregated
Parametric segregated
Trme depandert segregated

Adaptive mesh refirement
Ogtamz stion/Senslrvly

Plot while sohving

Plot Settings....

Advanced

Unear system sg

Linear systemfoiver:  Dinect (PARDISO)

Matrix symmetry

Automatic -

2. In the Menu bar go to Solve > Solve Manager > Solve For > Select Incompressible

Navier-Stokes > Click Solve
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Salver Manager 5]

Inkial Vohue | Solve For | Output [ Sequence
Solve for variables:

Geom (30}
- [ =soible Navier-Stokes (chns)

L]

j

.
L
L]
Canvectian and Diffusion (ched)
® cl
LR~

& Geom2 [20)

3. When solving is done, repeat step 19 for Convection and Diffusion

Solver Manager

Intial Vakue | Sohve For | Output [ Sequence
Solve for variables:
Gaom! (30)

Incompressible Navier-Stokes (chvis)
LN
®u
® v
L
. 0

A.6. Analyzing Results.

1. To analyze results, in the Menu bar go to Postprocessing and choose one of the

analysis methods.
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Princioal | Stresmine | Partide Traong | MaxiMn | Deform | _Anmate |
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Isomurface
i Sohution at angle (phase): 0 degrees

| Boundary
Edge

Aarom

Geometries to use

Principal
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2. Pressure Drop and Shear Stress Distribution

In the Menu Bar go to Postprocessing > Plot Parameters > A window will pop
up.

Select Boundary > Set Predefined quantities as Pressure > Set Unit
accordingly > Click OK.

In the Menu Bar go to Postprocessing > Plot Parameters > A window will pop
up.

Select Boundary > Set Predefined quantities as Viscous force per area, z

component > Set Unit accordingly > Click OK.
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Plot Parameters ﬁ
Principal | Streamiine | Particle Tracing | MaxiMin | _Deform | Animate
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3. Velocity Profile

e Inthe Menu Bar go to Postprocessing > Cross-Section Plot Parameters >
Click Point > Set Predefined quantities as Velocity field > Set Unit accordingly
> Set Coordinates accordingly > Click OK.

e Result will be shown up, figure below,
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4. Nutrient Concentration Profile

e In the Menu Bar go to Postprocessing > Plot Parameters > Click Slice > Set
Predefined quantities as Concentration, c1 for oxygen OR Concentration, c2

for glucose > Set Unit accordingly > Set Number of levels as 5 for x levels >

Click OK.
F
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5. To export data and figure, in the Menu Bar go to File > Export > Image > Window

will pop up, then click Export > Save with a desired name > Export.
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